Contents

Send Us Your Comments

Preface

1 Overview

Movement Statistics Overview ........................................................................................................... 1-1
What is Movement Statistics? ......................................................................................................... 1-1
Oracle Movement Statistics Features .......................................................................................... 1-2
Movement Statistics Process Flow ............................................................................................... 1-7
Record Creation ............................................................................................................................. 1-8
Record Verification ......................................................................................................................... 1-9
Record Reporting .......................................................................................................................... 1-10
Reporting Requirements ................................................................................................................. 1-10

2 Setup

Prerequisites ...................................................................................................................................... 2-1
Setup Process Flow ........................................................................................................................ 2-2
Commodity Codes using Category Sets ....................................................................................... 2-2
Economic Zones ............................................................................................................................ 2-3
Movement Statistics Validation Rules ......................................................................................... 2-4
Movement Statistics Parameters ................................................................................................. 2-6
Define Legal Entity - Economic Zone Parameters ..................................................................... 2-10
Triangulation Support in Oracle Movement Statistics ................................................................ 2-15
  Triangulation Support Overview .............................................................................................. 2-15
  Defining Triangulation .............................................................................................................. 2-16
  Triangulation Mode Setup ......................................................................................................... 2-19
3 Movement Statistics Record Creation

Movement Statistics Processor Overview.............................................................. 3-1
  Strategy for Running the Movement Statistics Processor................................. 3-1
  Movement Statistics Transactions.................................................................... 3-1
Movement Statistics Submission Parameters....................................................... 3-3
Query Movement Statistic Records..................................................................... 3-4
Display Movement Statistics Records.................................................................. 3-6
Find Movement Statistics Window....................................................................... 3-7
Movement Statistics Summary Window- Single Record........................................ 3-9
Movement Statistics Details Window...................................................................... 3-10
Manual Creation of Movement Statistic Records............................................... 3-16
Consigned Receipts and Consigned Returns......................................................... 3-18

4 Verification of Movement Statistics

Exception Report Overview....................................................................................... 4-1
Exception Report and Validation Rules................................................................. 4-3
Record Verification .................................................................................................. 4-4
Correcting Movement Statistics Exceptions.......................................................... 4-5
  Correcting Exceptions Process........................................................................... 4-6
  Standard Validation Rule Exceptions.................................................................. 4-6
  Default System Validation Exceptions............................................................... 4-7
  User Defined Validation Rules............................................................................... 4-8
Movement Statistics Ignore Record Status............................................................ 4-8

5 Movement Statistics Reports

Movement Statistics Reports.................................................................................. 5-1
Movement Statistics Standard Reports................................................................. 5-2
Movement Statistics Report Submission Process................................................. 5-5

6 Movement Statistics Declarations

Declaration Process................................................................................................ 6-1
7 Adjustments to Movement Records
   Making Adjustments................................................................. 7-1
   Manual Record Adjustments.................................................... 7-1
   Making Retroactive Price Adjustments....................................... 7-4
   Automatic Record Adjustment.................................................. 7-7

8 Movement Statistic Utilities
   Movement Statistics Record Purge Utility.................................... 8-1
   Movement Statistics Reset Status Utility.................................... 8-1

A Movement Statistics Data
   European Union Member Countries......................................... A-1
   Movement Statistic Field Definitions........................................ A-2
   Movement Statistics Record Status.......................................... A-18
   User Defined Validation Rules................................................ A-29
   Export Data File Format.......................................................... A-31
      Arrival Record Format....................................................... A-31
      Dispatch Record Format................................................... A-35

Index
Send Us Your Comments

Part No. B31584-02

Oracle welcomes customers’ comments and suggestions on the quality and usefulness of this document. Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

- Are the implementation steps correct and complete?
- Did you understand the context of the procedures?
- Did you find any errors in the information?
- Does the structure of the information help you with your tasks?
- Do you need different information or graphics? If so, where, and in what format?
- Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the name of the company who has licensed our products, the title and part number of the documentation and the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to check that you have the latest version of the document and if any concerns are already addressed. To do this, access the new Applications Release Online Documentation CD available on My Oracle Support and www.oracle.com. It contains the most current Documentation Library plus all documents revised or released recently.

Send your comments to us using the electronic mail address: appsdoc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at www.oracle.com.
Preface

Intended Audience


Implementers

See Related Information Sources on page x for more Oracle Applications product information.

TTY Relay Access to Oracle Support Services

To reach AT&T Customer Assistants, dial 711 or 1.800.855.2880. An AT&T Customer Assistant will relay information between the customer and Oracle Support Services at 1.800.223.1711. Complete instructions for using the AT&T relay services are available at http://www.consumer.att.com/relay/tty/standard2.html. After the AT&T Customer Assistant contacts Oracle Support Services, an Oracle Support Services engineer will handle technical issues and provide customer support according to the Oracle service request process.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible to all users, including users that are disabled. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Accessibility standards will continue to evolve over time, and Oracle is actively engaged with other market-leading technology vendors to address technical obstacles so that our documentation can be accessible to all of our customers. For more information, visit the Oracle Accessibility Program Web site at http://www.oracle.com/accessibility/.
Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The conventions for writing code require that closing braces should appear on an otherwise empty line; however, some screen readers may not always read a line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or organizations that Oracle does not own or control. Oracle neither evaluates nor makes any representations regarding the accessibility of these Web sites.

Structure

1 Overview
2 Setup
3 Movement Statistics Record Creation
4 Verification of Movement Statistics
5 Movement Statistics Reports
6 Movement Statistics Declarations
7 Adjustments to Movement Records
8 Movement Statistic Utilities
A Movement Statistics Data

Related Information Sources

Oracle Inventory User’s Guide

Oracle Applications User’s Guide

Integration Repository

The Oracle Integration Repository is a compilation of information about the service endpoints exposed by the Oracle E-Business Suite of applications. It provides a complete catalog of Oracle E-Business Suite’s business service interfaces. The tool lets users easily discover and deploy the appropriate business service interface for integration with any system, application, or business partner.

The Oracle Integration Repository is shipped as part of the E-Business Suite. As your instance is patched, the repository is automatically updated with content appropriate for the precise revisions of interfaces in your environment.

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle Applications data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an Oracle Applications form can update many tables at once. But when you modify Oracle Applications data using anything other than Oracle Applications, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications automatically checks that your changes are valid. Oracle Applications also keeps track of who changes information. If you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.
Overview

This chapter covers the following topics:

- Movement Statistics Overview
- Oracle Movement Statistics Features
- Movement Statistics Process Flow
- Record Creation
- Record Verification
- Record Reporting

Movement Statistics Overview

What is Movement Statistics?

Movement statistics is a system for collecting and recording the movement of material across international borders under the direction of government legislation.

The development of Oracle's movement statistics solution was prompted by requirements from the European Union (EU). Specifically, with the new open-border policy of the EU, one of the primary requirements was trade statistics reporting. Trade statistics are used by governments to help set trade policy, generate initiatives on new trade areas, to assess volumes of goods moving and to allow planning of future transport infrastructure needs. To fully understand Oracle's movement statistics solution, a review of the European Union’s movement statistics reporting requirements provides a good starting point.

The European Union (EU) placed their movement statistics requirements under the heading of INTRASTAT. INTRASTAT, according to the INTRASTAT General Guide, Notice 60 (UK), is the system for collecting statistics on the trade in goods between the countries of the European Community (EC). It came into operation on the first of January 1993, replacing customs declarations as the source of trade statistics within the EC.
Prior to 1993, every shipment of goods passing from one EU member state to another - from Britain to France, for example - had to be accompanied by export documentation, which identified the nature and value of the goods, its origin and destination. As well as being used for the collection of taxes and duties, the information collected using these forms was used by the individual national governments of the EU member states to compile trade statistics and national balance of trade computations.

In 1993 the EU, in anticipation of the abolishment of border controls, introduced the INTRASTAT system to harmonize the collection of trade statistics. The basis of INTRASTAT is that, every time goods cross from one state to another within the EU, an INTRASTAT declaration has to be made. However, instead of completing a form at the border, INTRASTAT declarations are submitted monthly. The European Commission has mandated these declarations in order to automate the legislative changes and business reporting requirements brought about by the creation of the European single market.

**Oracle's Movement Statistics Solution**

With Movement Statistics, you can collect statistics to satisfy the European Union’s reporting requirements for:

1. **INTRASTAT**: the declaration for imports and exports between countries belonging to the European Union.
2. **EXTRASTAT**: the declaration for imports and exports between a country belonging to the European Union and a country external to the European Union.

Oracle’s movement statistics solution is not specific to the European Community and can be implemented in any other economic zone, in any part of the world, such as the North American Free Trade Association (NAFTA).

**Oracle Movement Statistics Features**

The features of Oracle’s movement statistics solution are described below:

**Global Architecture**

The movement statistics system is built with a global architecture that provides the foundation for statistical reporting in any part of the world. This is achieved by the introduction of the following concepts:

- Economic zone
- Usage type: Type of transaction that originated the movement, either internal or external
- Statistical type: The format of the movement statistics record
To facilitate movement statistics setup and reporting according to European Union (EU) guidelines, the system has been pre-seeded (pre-loaded) with the following data:

- Countries - member states of the European Union (EU) and their EU designated codes
- Usage Types - internal and external
- Economic Zones - European Union (EU)
- Statistical Type - Intrastat and Extrastat
- Validation Rule - the rule set Standard_Validation is pre-seeded

**Legal Entity Level Reporting**

You capture and report movement statistics by legal entity. You are required to setup movement statistics for every legal entity to capture statistics. During setup, you specify parameters such as calendar, currency conversion type, weight unit of measure, tax office name, and tax office information and validation rules.

**Automatic Generation of Movement Statistics Records**

Movement statistics records are automatically generated by a batch program called the Movement Statistics Processor. The Movement Statistics Processor analyzes all the transactions that occur in the system in the context of a legal entity. The following transactions are examined:

- Purchase Receipts
- Return to Vendor (RTV)
- Sales shipments
- Return Material Authorization (RMA)
- Supplier Drop shipments (triangulation)
- Multi-organization intercompany drop shipments
- Inventory inter-organization movements
- Internal Requisitions and Internal Sales Orders

You can then validate the records and create official reporting documents.

Please note that miscellaneous inventory receipts and issues are not analyzed by the program, as these transactions are considered inventory updates, not material movements.
Purging Movement Statistics Transactions

Users may purge movement statistics transactions from the system through the use of a concurrent program.

Support for Manual Creation of Movement Statistics records

As an alternative to automatic generation, users can manually generate a statistical record. This mode of operating is mainly intended for backward compatibility reasons. Users opting for this mode will still benefit from the intelligent defaulting system and from the integration with legacy systems.

Also, you can manually enter movement information associated with material transactions that are not captured by Oracle Inventory and Oracle Purchasing, such as fixed assets.

Query and Modification of Movement Statistics Records

Users can query and manually modify existing movement statistics records through the Movement Statistics form.

Validate Movement Statistics Records

An Exception Report enables the users to validate that all the records in a period are well formed and ready for reporting.

You can use the Movement Statistics Exception Report to validate that all movement statistics records in a period are accurate and ready for reporting. You can identify missing or incomplete entries and make corrections before freezing the information.

In particular, it verifies that all the required information was provided in the transactional system.

A validation procedure is provided for both the exception report to validate the movement statistic record and for the movement statistics on-line form.

Paper Based Reporting

You can generate both summary and detail reports for movement statistics, including hard copies for government agencies and your own files.

Users can report on the movement statistics gathered for a period. The provided report is not country specific. Rather it is a comprehensive summary of all movement statistics data. To obtain country specific reporting users have to post-process the output to formatting according to local rules. Multiple currency is supported in this paper based reporting.

EDI Support

Users can generate EDI messages out of movement statistics information. These
messages (INSTAT and EXSTAT) are EDIFACT compliant.

Link Movement Statistics to Financial Documents
Movement statistics records are automatically linked to various financial documents based on the transaction type. For example, purchase order receipts are linked to payables invoices, RTVs and RMAs with credit memos, and sales order shipments with receivables invoices.

Track Multiple Values
You can capture the invoice value from accounts receivables and accounts payables for material movement. If the invoice information is not available, the system captures the statistical value from the movement transaction.

Automatic Weight Calculation
Oracle Inventory calculates the weight of a material movement by converting the transaction quantity and unit of measure to the appropriate weight and weight unit of measure specified on the Movement Statistics Parameter window. You can set up the precision of the calculated weight up to five decimals and define how the weight should be rounded.

PTO and KIT Items Support
For PTO models, Oracle Inventory creates movement records for all the included shippable items and KIT Items. You can configure KIT items on the Movement Statistics parameters and define whether you want to create movement records for the parent KIT items or the child shippable items. Additionally, a new call out program is available so customers can assign a price to the included shippable items according to their requirements. By default, the price applicable for the order line of the included shippable item is used for creating the movement record.

INTRASTAT / EXTRASTAT
Oracle movement statistics solution provides the functionality for collecting statistics associated with the movement of material across the border of two countries. You can collect statistics to satisfy the European Union's reporting requirements for:

- **INTRASTAT**: the declaration for imports and exports between countries belonging to the European Union.
- **EXTRASTAT**: the declaration for imports and exports between a country belonging to the European Union and a country external to the European Union.

Call Out Program
Users may define their own values for movement statistics records. Using the Call Out
Program, you can define a value for some or all movement statistic attributes and have the Movement Statistics Processor insert the value automatically. For each movement statistics record, a call out to an external system is made. This call out is initially empty but customers can use it to derive some attributes from external legacy systems that they might own.

For example, a customer using a third party transportation management system can derive transportation information for each record from that system.

**Triangulation Support**

Oracle’s movement statistics solution supports triangular trade reporting with concept of ‘triangulation mode’. Triangulation mode specifies how the Movement Statistics Processor analyzes and generates movement statistics records when it encounters a triangular trade transaction. There are two triangulation modes possible:

- **Invoiced Based**: a movement record is based on the invoice, not the physical movement of goods.
- **Shipment Based**: a movement record is created on the physical movement of goods only

**IDEP Support**

Oracle movement statistic’s solution will create a data export file with all the necessary data for you to make legal declarations via electronic means including EDI and IDEP. Use the Movement Statistics Create Export Data concurrent program to create this data file.

**Reference Period Support**

The reference period is the date on which a movement transaction is said to have taken place, either the invoice date or the shipment date. Oracle’s Reference Period solution is based on setting the Reference Period Rule Parameter. With the Reference Period Rule Parameter, you select one of the following Reference Period Rules:

- **Shipment Based**: the Movement Statistics Processor will use the date that the transaction took place as the reference period.
- **Invoice Based**: the Movement Statistics Processor will use the date that the transaction was invoiced as the reference period.

**Ignore Record Status**

You can now set the status of a movement records to IGNORE. Movement records with this status will not be processed or reported, either permanently or temporarily.
Oracle’s movement statistics solution process flow can be divided into four major components:

1. Record Creation: the Movement Statistics Processor creates records
2. Record Verification: using the Exception Report, verify all records
3. Record Reporting: check data using Detail or Summary Reports
4. Legal Declarations: transmit movement statistics data to government
Record Creation

Movement Statistics Processor

In Oracle's movement statistics solution, the Movement Statistics Processor captures all
movement transactions within a specified legal entity and date range. You can run the
Movement Statistics Processor at any time, although it is suggested that you run it at
least once a day (depending on your transaction volume).

Manual Record Creation
As an alternative to automatic generation using the Movement Statistics Processor, you
may manually create a movement statistic record. Refer to the Movement Statistics
Record section of this guide for additional information.

Record Status
Upon creation of the movement statistics records, the Movement Statistics Processor
sets the status of all new records to OPEN.

Record Verification

Movement Statistics Exception Report
Oracle’s movement statistics solution provides an automated way to verify movement
statistics records. You run the Movement Statistics Exception Report and all records
without exceptions are automatically updated to VERIFIED. Records that have
exceptions are listed on the Exception Report. You correct movement records on-line
and rerun the exception report.

Manual Validation
You may also validate records on-line manually, without running the Movement
Statistics Exception Report. Once successfully verified on-line, the record status will be
updated VERIFIED.

Validation Rules
Movement records are verified against validation rules. You may define your own
validation rules or use the default rules to validate movement records. Validation Rules
verify the completeness of your movement statistics records.

Record Status
The status of all records that have been successfully verified and contain no exceptions
are updated to VERIFIED.

At any time you may update a movement statistics record manually using the
Movement Statistics on-line forms. Only records with a status of OPEN or VERIFIED
may be modified.
Record Reporting

Summary and Detail Reports

The Summary and Detail Reports are a comprehensive summary of movement statistics records and should be used to check for data completeness. You may run these reports at any time. These reports are not intended to be used for official reporting.

Reporting Requirements

Each country requiring movement statistics may have different reporting requirements including formats, amounts, quantities, reporting periods, etc. You will need to familiarize yourself with every country’s requirements to be in compliance with local government regulations.

Note that Oracle’s movement statistic solution does not provide for country specific reporting. The reports that are provided by Oracle’s solution are generic in nature, meant to be used to verify that the correct movement transaction data was captured. To report movement statistics in country specific formats, you will be required to format and create the necessary report(s) or make declarations electronically. This requirement will be explained in detail in the Movement Statistics Reports Section.

Official Summary Report

Official Summary Reports update the status of all movement statistics records within a specified legal entity, period, and transaction type from VERIFIED to FROZEN. The only method of updating a record status from VERIFIED to FROZEN is by running this report.

Note: The Official Summary Report will not run successfully if any record within the specified period has a status of OPEN.

The Official Summary Report is meant for your records and not for making movement statistics declarations to the government authorities.

Electronic Transmission

Your country may accept electronic transmission of movement statistics declarations. You will need to familiarize yourself with the transmission methods accepted by your country.

Note: the status of movement statistics records must be FROZEN before attempting to transmit electronically.

The following is a list of transmission methods currently being used:
• EDI - Electronic Data Interchange - EDIFACT / CUSDEC / INSTAT - via network, diskette, tape, or as an e-mail attachment

• IDEP / CN8 - Intrastat Data Entry Package

• ASCII file format

Please refer to the 'Movement Statistics Declarations' section of this manual for a detailed explanation.

Record Status

Once the Official Summary Report has been run, the status of each movement statistics record is FROZEN.

If movement statistics declarations are made via EDI, the status of each movement statistic record transmitted in this manner is EDI.

Modifying Records

You may not modify any movement statistics records with a status of FROZEN. You may, if required, reset the status of a record with the Movement Statistics Reset Status utility program. This program will update the status of all records to OPEN. Note that if you reset the status of a record, you will have to reverify and run the Official Summary Report to update the status back to FROZEN.

Ignore Record Status

You can now set the status of a movement records to IGNORE. The purpose of the IGNORE record status is to enable you to remove a record from further processing and reporting, either permanently or temporarily.
This chapter covers the following topics:

- Prerequisites
- Setup Process Flow
- Commodity Codes using Category Sets
- Economic Zones
- Movement Statistics Validation Rules
- Movement Statistics Parameters
- Define Legal Entity - Economic Zone Parameters
- Triangulation Support in Oracle Movement Statistics
- Reference Period
- Additional Required Setup
- Adaptation of Oracle Movement Statistics to Local Requirements

**Prerequisites**

Setup and implementation of Oracle’s movement statistics solution is only possible through one of the two following Oracle applications:

- Oracle Inventory
- Oracle Purchasing

You only need to setup Movement Statistics in either Oracle Inventory or Purchasing. You do not need to perform the setup in both applications.

Setup Process Flow

The general process flow for setting up Oracle Movement Statistics. This process flow may be used in either Oracle Inventory or Oracle Purchasing. Once you have implemented movement statistics, you will be able to track movement of material across borders, including INTRASTAT and EXTRASTAT.

1. **Define Category Set:** Define a Commodity Code Category Set and assign commodity codes to items.

2. **Define Economic Zone:** Define the economic zones in which you conduct business and where you want to track movement transactions.

3. **Define Validation Rules:** Define Validation Rules to validate the entry of movement transactions and to properly report the information.

4. **Define Parameters:** Define Movement Statistics Parameters to specify the rules for gathering movement statistics.

Commodity Codes using Category Sets

One of the requirements of movement statistics is to group goods into commodity codes. For example, the European Union requires that you classify your goods by using the appropriate commodity code in the INTRASTAT Classification Nomenclature (ICN). The INTRASTAT commodity codes are predefined codes which uniquely identifies a class of products. The Commodity Codes are taken from the INTRASTAT Classification Nomenclature (ICN) which is common to all EU countries.

With Oracle's movement statistics solution, you use categories and category sets to group the goods you will be transacting into the correct commodity codes. Oracle defines a category as a logical classification of items that have similar characteristics. A category set is a distinct grouping scheme and consists of categories. You may set up categories and category sets in either Oracle Inventory or Oracle Purchasing.

Using either Oracle Inventory or Oracle Purchasing, you must define the flexfield structures, categories and category set for the commodity codes (refer to the respective user guides for additional information on these topics). Once you have completed this, use the Movement Statistics Parameters form to assign the category set to an economic zone (refer to the Define Movement Statistics Parameters section of this chapter).

**Define Categories / Category Sets:**

1. **Define Flexfield Structure**
   
   Define a Validation Set flexfield structure for Intrastat.

2. **Define Category Codes**
You should be using the flexfield structure name that you created in Step 1. Enter the Intrastat Classification Nomenclature (ICN) commodity codes that you will be using. Each commodity code will be a separate category.

3. Define Category Set
   • Create the Intrastat category set:
     • Name: Intrastat
     • Description: Intrastat Commodity Codes
     • Flexfield Structure: Intrastat
     • Controlled At: Master Level
     • Default Category: Select one of the Category Codes you created in Step 2.

4. Assign Items to Category Codes
   Assign your items to the Category Codes. Click Assign to do this.
   Note: You should assign your items to category codes in the Master Item Organization only.

5. Assign Category Set to an Economic Zone
   The Category Set that you have defined must be assigned to the Economic Zones that you will be using. You assign the Category Set in the Movement Statistics Parameters form.

**Economic Zones**

You use the Economic Zones form to define the economic zones where you conduct business. The Economic Zone form enables you to add and remove the countries that make up an economic zone. You may create any number of economic zones. For example, the European Union and the North American Free Trade Association (NAFTA) are economic zones.

Economic zones are used for gathering, reviewing, and reporting statistical information associated with material movements within the specified zone. Oracle’s movement statistics solution uses this information to determine which material movement transactions take place in a reporting jurisdiction.

Oracle’s movement statistics solutions provides a pre-seeded (pre-loaded) Economic Zone:
   • European Union (EC)
Economic Zone Definition Process:

1. **Verify economic zone**: Movement Statistics provides a pre-seeded (or pre-loaded) Economic Zone. This step verifies that the European Union Economic Zone has been loaded.

2. **Add additional economic zones**: Add additional economic zones (other than the pre-seeded zones) as required.

   **Note**: You can associate a country with more than one economic zone.

3. **Update economic zones**: Update an existing economic zone (add or remove countries) as required.

Movement Statistics Validation Rules

You use the Movement Statistics Validation Rules form to define and maintain the following rule types:

- Attribute Property Validation Rules: used to validate movement transactions in order to properly report transaction information
• Alternate Unit of Measure (UOM) Rules: used to set up alternate units of measure to the default unit of measure

Oracle's movement statistics solution provides a pre-seeded (pre-loaded) attribute property validation rule set called Standard_Validation. You may also define your own validation rule.

There is no pre-seeded Alternate UOM. If you require Alternate UOM Rules, you must define your own.

Whether you define your own validation rules or use the pre-seeded one, you use attribute property validation rules to specify what data is required for your specific reporting needs.

Oracle’s Validation Rules and Exception Report work together: if required data is missing or incorrect (as specified by a validation rule) an exception will be raised and listed on the Movement Statistics Exception Report.

Movement Statistics Validation Rules Window (for Attribute Property Rules)
1. **Define the Attribute Property Rule Set**: Optionally, define a new attribute property rule set.

   **Note**: A pre-seeded Attribute Property rules Set name: Standard_Validation is provided.

   you do not need to perform this step if you plan to use the pre-loaded rule set.

2. **Define the Alternate UOM Rule Set**: Define the Alternate UOM Rule Set.

   **Note**: There is no pre-seeded Alternate UOM rule Set.

   You use the same window to define the Attribute Property and the Alternate UOM

---

**Movement Statistics Parameters**

Use the Movement Statistics Parameters form to define and maintain the parameters for gathering movement statistics. The parameters that you define are used by the Movement Statistics Processor to collect movement transaction data and create movement statistics records.

The Movement Statistics Processor captures and report movement statistics by legal entity. You are required to define Movement Statistics Parameters for every legal entity to capture statistics.
You use two forms for defining and maintaining Movement Statistics parameters:

- Movement Statistics Parameters form

**Movement Statistics Parameters Form**

- Statistics Type Usages form
Define Movement Statistics Parameters Process:

1. Define the legal Entity Economic Zone Assignment (required): You must assign the Economic Zones to the Legal Entities where you plan to capture movement statistics data.

   **Note:** You must assign an economic zone to every legal entity you use.

2. Define the Legal Entity Economic Zone parameters: Define the specific usage types, statistical types, and other parameters for the Legal Entity Economic Zones.

   **Note:** You must assign parameters for all Legal Entity Economic Zone pairings you define.

3. Select a value for the Returns Processing field. Returns processing determines if you want to aggregate return movement transactions within a reporting period:
   - Aggregate Returns: If you select this option, the movement statistics processor
will:

- Aggregate sales order shipments with customer returns within a period (if the sales order shipment has not been declared). If the sales order shipment has been declared, customer returns will not be aggregated.

- Aggregate purchase order receipts with return to vendor (if the purchase order receipt has not been declared). If the purchase order receipt has been declared, returns to vendor will not be aggregated.

- Separate Returns (default value): If you select this option, the movement transactions will not be netted. A separate movement record will be created for all source types, including purchase orders, return to vendor, sales orders, and customer returns.

Note: Additional Notes for Aggregate Returns

- For Customer Return (RMA) transactions, unless you enter the sales order reference number and order line number information on the return order line, the RMA and corresponding Sales Order will not be aggregated. A separate movement record with negative movement amount, quantity, and invoice of type dispatch adjustment will be created for the customer return movement transaction.

- Arrival movement records (with a source type of purchase order) and a movement status of Open, Verified, or Ignore will be aggregated with return to vendor transactions that occur within the same period.

- Movement records with a status of Frozen, Export, or EDI will not be aggregated. For example, if the arrival movement record has a status of Frozen and a return to vendor transaction is processed, the return will not be aggregated with the arrival movement record. The processor will create a separate dispatch movement record.

- Dispatch movement records (with a source type of sales order) and a movement status of Open, Verified, or Ignore will be aggregated with customer return transactions that occur within the same period.

- If the return transaction does not occur in the same period as the original arrival or dispatch, a separate adjustment movement record with negative movement amount, quantity,
invoice amount and invoice quantity will be created

**Example of Aggregate Returns**
The following example illustrates the consequence of aggregating movement transactions:

Within the same reporting period, the following movement transactions take place:

- A movement based on a receipt transaction of ten units of item A, priced at $6/each and invoiced at $60 is processed by the movement statistics processor.

- A movement based on a return to vendor transaction of one unit of item A and invoiced (credit memo) at $6 is processed by the movement statistics processor. Theses transactions are aggregated resulting in: one movement record with a net movement amount of $54 and a net movement quantity of nine units and net invoice of $54.

**Example of Separate Returns**
In separate reporting periods, the following movement transactions take place:

- A movement based on a receipt transaction of 10 units of item A, priced at $6/each and invoiced at $60 is processed by the Movement Statistics Processor in Period 1.

- A movement based on a return to vendor transaction of 1 unit of item A and invoiced (credit memo) at $6 is processed by the Movement Statistics Processor in Period 2.

The Movement Statistics Processor will not aggregate these transactions:

- One arrival movement record with a movement amount of $60, and a movement quantity of 10 units and invoice of $60 in Period 1.

- One dispatch movement record with a movement amount of - $6 and a movement quantity of -1 units and credit memo of -$6 in Period 2.

  **Note:** The amount, quantity, and invoice will be negative.

---

**Define Legal Entity - Economic Zone Parameters**
The Economic Zone parameter defines the behavior of Oracle's movement statistics solution. You must define the parameters for every Legal Entity - Economic Zone pairing you have defined. The following parameters must be set:
### Economic Zone Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Possible Values</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Usage Type</td>
<td>Internal</td>
<td>Internal: Movement of goods within countries of the specified economic zone</td>
</tr>
<tr>
<td></td>
<td>External</td>
<td>External: Movement of goods from a country of one economic zone to a country outside the economic zone</td>
</tr>
<tr>
<td>Statistical Type</td>
<td>Intrastat</td>
<td>Intrastat: Declaration of imports and exports within EC</td>
</tr>
<tr>
<td></td>
<td>Extrastat</td>
<td>Extrastat: Declaration of import and exports between EC and countries external to EC</td>
</tr>
<tr>
<td>Period Set</td>
<td>Period Set Name</td>
<td>Select a Period Set (from LOV) that reflects your reporting frequency (monthly, quarterly)</td>
</tr>
<tr>
<td>Period Type</td>
<td>Period Type</td>
<td>Select a Period Type (from LOV) to use for reporting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note that the calendar you use for statistical reporting purposes is independent of the accounting calendar for your organization’s set of books.</td>
</tr>
<tr>
<td>Start Period</td>
<td>Start Period</td>
<td>Assign the first period for which the Usage / Statistic type assignment is valid.</td>
</tr>
<tr>
<td>End Period</td>
<td>End Period</td>
<td>Optionally, enter the last period for which this assignment is valid.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Possible Values</td>
<td>Comments</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------</td>
<td>----------</td>
</tr>
</tbody>
</table>
| Weight UOM        | Weight Unit of Measure | Enter the default UOM.  
Note: INTRASTAT requires weight (mass) to be reported in KG |
<p>| Precision         | 0 to 5          | Enter the number of decimals the total weight should be rounded to. The default value is 0 (zero) meaning the weight will be rounded to the nearest digit. |
| Report Rounding   | Possible values: | Set up how the calculated weight will be rounded: |
|                   | • Normal        | • Normal (default value): Weight is rounded to the nearest value with number decimals as defined by the precision setting. |
|                   | • Truncate      | • Truncate: Weight is truncated to the number of decimals as defined by the precision setting. |
|                   | • Up            | • Up: Weight is rounded to the highest value with number decimals as defined by the precision setting. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Possible Values</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dispatch KIT Method</td>
<td>Possible values:</td>
<td>Indicates how movement records should be created for KIT dispatches:</td>
</tr>
<tr>
<td></td>
<td>• KIT</td>
<td>• KIT: Movement records will be created for the KIT items.</td>
</tr>
<tr>
<td></td>
<td>• Shipped Components</td>
<td>• Shipped Components: Movement records will be created for the child shippable items.</td>
</tr>
</tbody>
</table>

| Entity Branch Reference           | Entity Branch Reference | Enter the name of the legal entity branch. Note: this reference is printed on the European Union INTRASTAT and EXTRASTAT declaration. |

| Conversion Type                  | Conversion Type       | Select the currency conversion type (from LOV) to use to convert foreign currency amounts to the functional currency of your organization's set of books. |

| Conversion Option                | Conversion Option     | Select the conversion option (daily or last day of the period) to convert foreign to functional currency. |

<p>| Category Set                     | Category Set          | Select the category set that you defined for the INTRASTAT Commodity Codes. Note: you must define category sets (see: Commodity Codes using Category Sets in this guide). |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Possible Values</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Office Code</td>
<td>Tax Office Code</td>
<td>Enter the Tax Office Code of the tax office to which your legal entity reports.</td>
</tr>
<tr>
<td>Tax Office Location Code</td>
<td>Tax Office Location Code</td>
<td>Enter the Name for the tax office to which your legal entity reports.</td>
</tr>
<tr>
<td>Attribute Rule Set</td>
<td>Enter the validation rule set code.</td>
<td>The default rule set is 'Standard_Validation'. You may define your own rule set.</td>
</tr>
<tr>
<td>Alternate UOM Rule Set</td>
<td>This parameter is optional.</td>
<td>You will need to define an Alternate UOM Rule Set.</td>
</tr>
<tr>
<td>Triangulation Mode</td>
<td>Invoice Based</td>
<td>Triangulation Mode determines how the Movement Statistics Processor will process Triangulation (drop-shipments):</td>
</tr>
<tr>
<td></td>
<td>Shipment Based</td>
<td>Invoice Based: the processor will process movement transactions based on the flow of the invoice</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shipment Based: the processor will process movement transactions based on flow of goods</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See: Triangulation Support in the following section of this chapter.</td>
</tr>
<tr>
<td>Reference Period</td>
<td>Shipment Based</td>
<td>Shipment Based: the date that the transaction took place</td>
</tr>
<tr>
<td></td>
<td>Invoice Based</td>
<td>Invoice Based: the date the transaction was invoiced</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Refer to the Reference Period section in this chapter</td>
</tr>
</tbody>
</table>
### Parameter Possible Values Comments

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Possible Values</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advance Invoice Days</td>
<td>User Defined</td>
<td>The number of days the processor should look for an advance invoice</td>
</tr>
<tr>
<td>Pending Invoice Days</td>
<td>User Defined</td>
<td>The number of days the processor should look for an invoice in the period following the movement transaction</td>
</tr>
</tbody>
</table>

### Triangulation Support in Oracle Movement Statistics

Oracle's movement statistics solution supports triangulation. This section will:

- Review Oracle's movement statistics solution support of triangulation
- Define triangulation using examples to illustrate triangular trade transactions
- Describe the setup for making triangular trade declarations

### Triangulation Support Overview

Oracle's movement statistics solution supports triangular trade with the concept of 'triangulation mode.' Triangulation mode specifies how the Movement Statistics Processor analyzes and generates movement statistics records when it encounters a triangular trade transaction. You must determine how you will report triangular trade transactions by setting this parameter. There are two possible values for the Triangulation Mode parameters:

- Invoiced Based
- Shipment Based

The default Triangulation Mode parameter is invoiced based.

### Invoiced Based

Invoiced Based - the Movement Statistics Processor creates movement statistics records based on the issue of an invoice only. A movement record will be created for the invoice and not for the physical movement of goods.
Shipment Based

Shipment Based - the Movement Statistics Processor creates movement statistics records based on the movement of goods only. The invoice will not result in a movement record.

Defining Triangulation

This section will define triangulation using the following examples:

- Transaction between three trading partners in three countries

The resulting movement records created, based on both Shipment Based and Invoiced Based Triangulation Modes, will also be described.

The example used here is a simple triangular trade transaction. Many variations are possible, including, but not limited to:

- Transactions involving trading partners in countries within an economic zone
- Transactions involving trading partners in countries outside an economic zone
- Transactions between trading partners in two countries
- Transactions between four trading partners in three countries

Note that the countries used in the examples are for illustration purposes only, you may substitute any country of your choosing.

Triangular Trade Between Three Countries

For the purposes of defining triangular trade the following triangulation example will be used:

- Your Company is located in Italy and using Oracle's movement statistics solution
- Your Supplier is located in Spain
- Your customer is located in France
The following triangular trade takes place:

1. Your customer in France places an order with you in Italy.
2. You source the order from Spain.
3. Spain ships directly to your customer in France (goods are not shipped to Italy but directly from Spain to France).

The triangular trade results in the following transactions:

- You send a sales order to your customer in France
• You invoice your customer in France, creating the receivable
• You create a purchase order for your supplier in Spain
• Supplier in Spain sends you an invoice, creating the payable
• Spain creates a shipment to France, satisfying the sales order

Invoiced Based

Two movement records are generated by the Movement Statistics Processor, when run in Italy, based on the Invoiced Based Triangulation Mode parameter, as follows:

1. Sales Order (dispatch) record from Italy to France
   - Movement Amount: zero (no movement of goods took place between these countries)
   - Movement Quantity: zero (no movement of goods took place between these countries)
   - Extended Value: calculated as the invoice quantity multiplied by invoice price
   - Dispatch Country: Italy
   - Destination Country: France
   - Triangulation Country: Spain

2. Purchase Order (arrival) record in Italy from Spain
   - Movement Amount: calculated as the receipt quantity multiplied by unit price
   - Movement Quantity: zero (no movement of goods took place between these countries)
   - Extended Value: is calculated as the receipt quantity multiplied by unit price
   - Dispatch Country: Spain
   - Destination Country: Italy

   **Note:** France is required to declare an arrival of goods from Spain, however, running the movement statistics processor in Italy will not generate the arrival record in France.

Shipment Based

No movement records are generated by the Movement Statistics Processor, when run in Italy, based on the Shipment Based Triangulation Mode parameter.

Since no physical movement of goods occurred in Italy, a movement record will not be created.
Note: France is required to declare an arrival of goods from Spain, however, running the movement statistics processor in Italy will not generate the arrival record in France.

Triangulation Mode Setup

You define which triangulation mode to use in the Triangulation Mode parameter. This parameter is located on the Oracle Movement Statistics Parameters form.

Setting Triangulation Mode

During initial setup, you specify the Triangulation Mode to use, either Invoice Based or Shipment Based. The default Triangulation Mode is Invoiced Based. Once this parameter has been set, it is strongly suggested that you do not modify it.

Modifying Triangulation Mode

It is strongly suggested that once you have set the Triangulation Mode parameter that you do not modify it.

If it is necessary for you to modify the Triangulation Mode parameter, you should consider the following:

• modifying the Triangulation Mode parameter will not modify existing movement records. The parameter selected takes affect from the moment it is selected and is not retroactive to movement records previously created.

• consider that changing parameters during an open reporting period will result in a mix of movement records: some records will be created using the 'Invoiced Based' Triangulation Mode parameter and other set of records will have been created using the Shipment Based parameter.

Reference Period

This section reviews the concept of Reference Period as it is implemented with Oracle's movement statistics solution, including:

• Overview and Definition of Reference Period

• Overview of Oracle's Reference Period Functionality

• Reference Period Process Flow

• Implementing Reference Period

• Using Reference Period Rules and Expected Results
Reference Period Overview

The European Union has defined reference period as "the calendar month during which value added tax has become due for the intracommunity transactions to be recorded. The Member States may adapt this definition of the reference month to the particular tax rules applicable." (Article 2 of Commission Regulation (EEC) No 3590/92)

"In those Member States where the periodic statistical declaration is the same as the periodic tax declaration, the provision relating to the transmission of the statistical declaration shall be drawn up in line with Community or national tax regulations" (Commission Regulation No 3046/92).

Since, tax regulations differ between Member States, the interpretation of the reference period is not consistent and varies throughout the European Union.

For example, in the UK, the rules for assigning the reference period are as follows:

- No invoice is issued (or received) - Reference date is the 15th of the month following the movement of the goods.
- A tax invoice is issued more than one month prior to the dispatch of the goods - Reference date is the date of arrival / dispatch.
- An invoice is issued less than one month prior to the dispatch of the goods and before the 15th of the month following arrival / dispatch - Reference date is the date of invoice.
- If the invoice is not received by the 15th of the following month - Reference date becomes 15th of the month following arrival / dispatch.

From: Notice 60, The Intrastat General Guide UK

In France, the general rule for reference period is:

- for shipments, the month during which VAT becomes due for payment in the other member State as a result of the corresponding arrival
- for arrivals, the month during which VAT becomes due for payment in France. Tax becomes due on the 15th day of the month following the movement of goods or the invoice date if the invoice is issued before the 15th of the month following the movement of goods. Only invoices issued after the movement can determine the eligibility date.

From: La Periode de Reference, Texte n 01-12/o.14 (French Intrastat Guide)

And in Denmark,

- the reference period is generally the month in which the goods are received or shipped - regardless of the invoice date.
• If the invoice is not received or sent until after the deadline for the submission of the INTRASTAT declaration, the declaration of the specific movement of goods may be postponed until the following month.

From Danmarks Statistik Intrastat Guide

Reference Period Solution Overview

Oracle’s Reference Period solution is based on setting the Reference Period Rule Parameter. With the Reference Period Rule Parameter, you select one of the following Reference Period Rules:

1. Shipment Based: the Movement Statistics Processor will use the date that the transaction took place as the reference period (note this is the default Reference Period Rule):
   - For a sales order, the date the order was shipped is the reference date.
   - For a purchase order, the date the PO was received.

2. Invoice Based: the Movement Statistics Processor will use the date that the transaction was invoiced as the reference period.

Reference Period Process Flow:


1. Set the Movement Statistics Reference Period parameters
   - Using the Movement Statistics Parameters form, select a Reference Period Rule:
     - Shipment Based
     - Invoiced Based

2. Shipment Based Reference Period Rule Parameter
   - This is the default Reference Period Rule. To use this rule, select it from the LOV on the Movement Statistics Parameter form.

3. Invoiced Based Reference Period Rule Parameter: To use this Reference Period Rule you must also set two additional parameters:
   - Advance Invoice Days
   - Pending Invoice Days

4. Run the Movement Statistics Processor: Based on the Reference Period Parameter,
the Movement Statistics Processor will create records with the following status:

- **Shipment Based Reference Period Rule**: the reference date is based on the date of the transaction and the record is assigned a status of OPEN.

- **Invoiced Based Reference Period Rule**: the reference date is based on the date of the invoice and if the invoice is missing, the record will be assigned a status of PENDING; if an invoice is available, the record is assigned a status of OPEN. All records with a status of PENDING will be reprocessed every time the Movement Statistics Processor is run (until the status is updated to OPEN).

5. Run the Exception Report

Run the Movement Statistics Exception Report to validate your records in OPEN status and update the status to VERIFIED.

### Setting Up Reference Period Rule

This section reviews the setting up Reference Period Rules using the Movement Statistics Parameters form.

**Note:** please review and be familiar with the specific reporting requirements of your country when implementing Reference Period Rules.

### Reference Period Parameters

You must set the Reference Period Parameters using the Statistical Type Usages form.
The Reference Period Parameter values determine how the Movement Statistics Processor assigns the reference date. There are two possible values for this parameter:

**Shipment Based Reference Period Rule**

With this rule, the Movement Statistics Processor assigns the reference date based on the date the transaction took place (for both dispatches and arrivals). Note: this is the default Reference Period Rule.

**Invoice Based Reference Period Rule**

With this rule, the Movement Statistics Processor assigns the reference date based on the invoice date (for both dispatches or arrivals).

The Invoice Based Reference Period Rule requires that two additional parameters be set:

- **Advance Invoice Days**: this parameter specifies the number of days the Movement Statistics Processor and the Exception Report should search for an advance invoice (in the case where a transaction was invoiced before the movement transaction). The default value is 30 days, you may enter any whole number for this parameter. When the Advance Invoice Days parameter is set to 30, the Movement Statistics Processor will search for an advance invoice for 30 days prior to the date of the
movement transaction.

- The general rule for default Advance Invoice Days: if there is less than a 30 day difference between invoice date and transaction date, the invoice date becomes the reference date for declaration purposes.

- For example (using the default Advance Invoice Days value):

<table>
<thead>
<tr>
<th>Transaction Date</th>
<th>Invoice Date</th>
<th>Reference Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>June 25</td>
<td>No Invoice</td>
<td>July 15</td>
</tr>
<tr>
<td>June 25</td>
<td>June 1</td>
<td>June 1</td>
</tr>
<tr>
<td>June 25</td>
<td>June 20</td>
<td>June 20</td>
</tr>
<tr>
<td>June 25</td>
<td>May 1</td>
<td>June 25</td>
</tr>
</tbody>
</table>

- **Pending Invoice Days**: this parameter specifies the number of days the Movement Statistics Processor and the Exception Report should ‘wait’ for an invoice after the start of the following period, if there is no invoice on the date of the movement transaction. The default value is 15 days, you may enter any whole number for this parameter. When the Pending Invoice Days parameter is set to 15, the Movement Statistics Processor will ‘wait’ for an invoice for 15 days from the start of the period following the movement transaction.

- The general rule for Pending Invoice Days if using the default of 15 days: if an invoice is not received by the 15th day of the month following the movement transaction, the reference date is the 15th day of that month.

- For example (using the default Pending Invoice Days value):

<table>
<thead>
<tr>
<th>Transaction Date</th>
<th>Invoice Date</th>
<th>Reference Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>June 25</td>
<td>No Invoice</td>
<td>July 15</td>
</tr>
<tr>
<td>June 25</td>
<td>July 16</td>
<td>July 15</td>
</tr>
</tbody>
</table>
### Changing Reference Period Rules

To change the Reference Period Rules, the status of all movement records in all periods must be set to FROZEN. You will not be permitted to change Reference Period Rules if this condition has not been met. A message on the Movement Statistics Details form will be displayed if you attempt to change Reference Period Rules before this requirement is met.

### Using Reference Period Rule

This section reviews the results you should expect, in terms of transaction date and movement record status, of using both the Reference Period Rules. The results are based on the following scenarios:

- **Advanced Invoice**: transaction is invoiced in advance, prior to actual shipment or receipt transaction
- **Invoice after Transaction**: transaction is invoiced after the shipment or receipt transaction takes place

### Shipment Based Reference Period Rule

This section describes the results of using the Shipment Based Reference Period Rule to determine the Reference Period.

**General Rule**

The general rule governing Shipment Based Reference Period Rule: the date of the movement transaction is the date used to determine the period in which the transaction is reported on Intrastat Declarations.

**Reference Period Display**

The Reference Period is displayed as the Transaction Date on the Movement Statistics Details form.

**Movement Record Status**

When the Movement Statistics Processor creates movement records under the Shipment Based Reference Period Rule, the status of the movement record will be OPEN.
Advance Invoice

In a case where the transaction was invoiced in advance, the reference date is the date of the actual movement transaction. The reference period will always be the date of the movement transaction, with or without an invoice. For example, if a purchase order was received on June 10, but invoiced on June 2, the Reference Period is June 10 for Intrastat Declarations.

Invoice After Transaction

In the case of an invoice arriving 10 days after the movement transaction takes place, the reference date is the date of the actual movement transaction. The reference period will always be the date of the movement transaction, with or without an invoice. For example, if a purchase order was received on June 10, but invoiced on June 20, the Reference Period is June 10 for Intrastat Declarations.

Invoice Based Reference Period Rule

This section describes the results of using the Invoiced Based Reference Period Rule to determine the Reference Period.

General Rule

The general rules governing Invoiced Based Reference Period Rule (using the default Advance and Pending Invoice Days values) are as follows:

1. If no invoice is issued (or received), the reference date will be assigned based on the Pending Invoice Days parameter value. Using the default Pending Invoice Days value of 15 days, the reference date is the 15th of the month following the month in which the movement of goods took place.

2. If an invoice is issued prior to the movement transaction by more than 30 days (the default Advance Invoice Days parameter value), the reference date is the date on which the movement transaction took place.

3. If an invoice is issued prior to the movement transaction by less than 30 days (the default Advance Invoice Days parameter value), the reference date is the date of invoice.

4. If an invoice is received after the movement transaction, but less than 15 days (the default Pending Invoice Days parameter value) in the month following the movement transaction, the reference date is the date of the invoice.

5. If an invoice is received after a movement transaction, but more than 15 days (the default Pending Invoice Days parameter value) in the month following the movement transaction, the reference date is the 15th of the month following the month in which the movement of goods took place.
Reference Period Display
The reference date of a movement record is displayed on the Movement Statistics Details form as the Transaction Date.

Movement Record Status
This section reviews the movement status of records governed by the Invoice Based Rule parameters.

If there is no invoice, the Movement Statistics Processor will create a movement record with a PENDING status.

The status of the movement record will remain PENDING until one of the following conditions are met:

- The movement transaction is invoiced. When the invoice is received, the status of the record will be updated to OPEN and the reference date will be determined by the Movement Statistics Processor based on either the Advance Invoice Days or the Pending Invoice Days parameter.

- The time frame specified by the Pending Invoice Days parameter expires without the transaction being invoiced. When this occurs, the status of the record will be updated to OPEN. The reference date will be determined by the Movement Statistics Processor based on the Pending Invoice Days parameter.

Every time the Movement Statistics Processor is run, it will reprocess every movement record with a status of PENDING and continue to do so until either the movement record is invoiced or the Advance Invoice Days or the Pending Invoice Days criteria have been satisfied. Once all the criteria have been satisfied, the status will be updated to OPEN and the reference date updated appropriately.

Advance Invoice
In a case where the transaction is invoiced in advance, the Movement Statistics Processor will use the Advance Invoice Days parameter value to determine for how many days to search for an invoice prior to the date of the movement transaction.

To understand the use of the Advance Invoice Days parameter with advance invoices, please review the following example scenarios:

Scenario 1: Invoiced more than 25 days prior to movement transaction
- The Advance Invoice Days parameter is set to 25 days
- An advance invoice is created on June 1
- A movement transaction occurs on July 15
- The Movement Statistics Processor will search for an invoice between the dates of
June 20 and July 15

- The invoice does not fall within the Advance Invoice Days parameter value of 25 days but the transaction was invoiced
- The reference date becomes the date of the transaction (July 15) and the movement record status is OPEN
- In this case, because there was an invoice (although outside the Advance Invoice Days parameter value), the reference date becomes the date of the movement transaction

Scenario 2: Invoiced less than 25 days prior to movement transaction

- The Advance Invoice Days parameter is set to 25 days
- An advance invoice is created on June 30
- A movement transaction occurs on July 15
- The Movement Statistics Processor will search for an invoice between the dates of June 20 and July 15
- The invoice is within the Advance Invoice Days parameter value of 25 days
- The reference date becomes the date of the invoice (June 30) and the record status is OPEN

Scenario 3: No invoice

- The Advance Invoice Days parameter is set to 25 days
- No invoice is created
- A movement transaction occurs on July 15
- The Movement Statistics Processor will search for an invoice between the dates of June 20 and July 15
- No invoice is found, either outside or within the Advance Invoice Days parameter value of 25 days
- The reference date can not be determined at this time and the movement record status is PENDING
- In this case, because there is no invoice, the Movement Statistics Processor will 'wait' for an invoice based on the Pending Invoice Days parameter value
Invoice After Transaction

In the case of an invoice arriving after the movement transaction takes place, the Movement Statistics Processor will use the Pending Invoice Days parameter value to determine how many days to search for an invoice in the month following the month the movement transaction occurred.

To understand the use of the Pending Invoice Days parameter with invoices, please review the following example scenarios:

Scenario 1: Invoiced after the movement transaction, within the time frame specified by the Pending Invoice Days parameter

- The Pending Invoice Days parameter is set to 20 days

- An invoice is created on August 2

- A movement transaction occurs on July 15

- The Movement Statistics Processor will search for an invoice between the dates of July 15 through August 20

- If the Movement Statistics Processor is run between July 15 and August 1, the status of the movement record will be PENDING
- When the Movement Statistics Processor is run on or after August 2, the status of the movement record will be updated to OPEN and the reference date is the date of the invoice (August 2)

- In this case, because the movement transaction was invoiced within the Pending Invoice Days value, the reference date becomes the date of the invoice

Scenario 2: Invoiced after the movement transaction, outside the time frame specified by the Pending Invoice Days parameter

- The Pending Invoice Days parameter is set to 20 days

- An invoice is created on August 25

- A movement transaction occurs on July 15

- The Movement Statistics Processor will search for an invoice between the dates of July 15 through August 20

- If the Movement Statistics Processor is run between July 15 and August 20, the status of the movement record will be PENDING

- When the Movement Statistics Processor is run on or after August 21, the status of the movement record will be updated to OPEN and the reference date becomes August 20
• In this case, because the movement transaction was not invoiced within the Pending Invoice Days value, the reference date becomes the 20\textsuperscript{th} of the month following the month of the movement transaction

Scenario 3: No invoice
• The Pending Invoice Days parameter is set to 20 days
• No invoice is created
• A movement transaction occurs on July 15
• The Movement Statistics Processor will search for an invoice between the dates of July 15 through August 20
• If the Movement Statistics Processor is run between July 15 and August 20, the status of the movement record will be PENDING
• When the Movement Statistics Processor is run on or after August 21, the status of the movement record will be updated to OPEN and the reference date becomes August 20
• In this case, because the movement transaction was not invoiced, the reference date becomes the 20\textsuperscript{th} of the month following the month of the movement transaction (as specified by the Pending Invoice Days parameter)

Additional Required Setup

The following required setups directly impact the functioning of Oracle Movement Statistics. You should verify that the following setups have been performed in their respective Oracle Applications:
• Item Weight
• Exchange Rate
• Delivery Terms

Note that these setups can not be performed from within Oracle's movement statistics solution. They must be performed in specific Oracle Applications, as defined below.

Item Weight

Intrastat regulations require that net weight (net mass) be reported. To report net weight correctly with Oracle's movement statistics solution, you must setup your inventory items with the net weight (not gross weight).

In Oracle Inventory, item weight is a Physical Attribute.
See: Oracle Inventory User’s Guide.

**Note:** INTRASTAT requires net weight (or mass) to be reported in KG. If you define the item weight in a unit of measure other than KG, you must define a conversion between KG and your item’s net weight unit of measure.

---

**Exchange Rate**

You must set up an exchange rate between every currency you transact in and your local currency.


---

**Delivery Terms**

Within the EU, delivery terms (sometimes referred to as Incoterms by the International Chamber of Commerce (ICC)) are used to determine when the transfer of title takes place in a transaction where goods are bought or sold.

Delivery terms are required to perform Intrastat reporting. The current set of valid EU delivery terms are pre-seeded in Oracle’s movement statistic solution. Additional delivery terms may be added as necessary.

Oracle’s movement statistics solution determines the delivery term for a movement transaction from the Freight on Board (FOB) point of a transaction. If you enter a value for freight on board for a sales order, purchase order, or inventory transaction, the value entered will be validated by the Movement Statistics Exception Report.

**Note:** Oracle movement statistics automatically inserts the delivery term in the movement record based on the value that you entered in the FOB field in the Oracle Purchasing Supplier form or in the FOB field in the Oracle Order Management Customer form. You may also modify the delivery term on-line using the Movement Statistics Details form.

The following are the Delivery Terms used by Oracle’s movement statistics solution:

- EXW - ex works
- FCA - Free Carrier
- FAS - Free Alongside Ship
- FOB - Free on Board
- CFR - Cost and Freight (C&F)
- CIF - Cost, Insurance, Freight
- CPT - Carriage Paid to Agreed Destination
CIP - Carriage and Insurance Paid to Destination
DAF - Delivered at Frontier
DES - Delivered ex Ship
DEQ - Delivered ex Quay
DDU - Delivered Duty Unpaid
DDP - Delivered Duty Paid
XXX - Delivery terms other than the above

Any value that you enter will be validated against this list of Delivery Terms. If your Delivery Terms do not match one of the listed terms, an exception will be listed by the Exception Report.

**Adaptation of Oracle Movement Statistics to Local Requirements**

Oracle’s movement statistics solution enables you to adapt certain setup parameters in order to meet country specific reporting requirements. With this functionality, you are able to customize certain features to adapt to local regulatory rules. This flexibility permits you to:

- Define customized Attribute Property Validation Rules
- Define Alternate UOM Rules
- Use the Call Out Program
- Define additional Economic Zones

**Define Attribute Property Rule Set:**

Oracle’s movement statistics solution provides a pre-seeded Attribute Property Rule Set called 'Standard_Validation.' The Standard_Validation Rule Set validates (and creates an exception) for following data fields for every Source Type:

- Transaction Code
- Transport Mode

If the 'Standard_Validation' rule set does not meet your requirements, you may define your own Attribute Property Rule Set. Defining your own rule set will enable you to specify what movement statistics data you require, by Source Type, for your country’s reporting needs. The rule set that you define will validate only the fields that you specify. Additionally, all the movement statistics attributes that you choose to validate will be displayed on the Movement Statistics Exception Report when an exception occurs.

To define Attribute Property Rules using the Validations Rule form:
1. Name your Attribute Property Rule Set.

2. For Rule Number assign a unique, non-repeating rule number.

3. Select a Source Types from the LOV.

4. Select an Attribute Name to associate with the Source Type from LOV.

5. Assign one of the following Attribute Rule Set Property combinations:
   - required / not updateable
   - not required / updateable
   - required / updateable
   - not required / not updateable

6. Select the Lookup Type from the list of values associated with your Attribute Property. A Lookup Type is defined using the using the Lookup form (refer to the Oracle Inventory User's Guide for additional information regarding defining Lookup Types).

   **Note:** Once you have defined your new Attribute Property Rule Set, you will have to update the Movement Statistics Parameters with your new rule set. Refer to the ‘Movement Statistics Parameters’ section of this guide for additional information.

Please refer to the Appendix for a complete listing all Source Types and Attribute Names that may be used in a user defined validation rule set.

**Copying an Attribute Rule Set:**

If you decide to use a 'user defined' Attribute Property Rule Set, you may copy an existing Attribute Rule Set using the Copy Tool. The Copy Tool will copy any existing rule set. You may then modify the copied rule set to meet your requirements.


2. Select the Tools option locate the Toolbar.

3. Select 'Copy Rule Set.'

4. Enter the Rule Set Code and Rule Set Name for your rule set.

5. Save your rule set.
6. You may modify any rule as your requirements dictate.

7. Save your rule set and all modifications.

8. Assign your rule set to the Attribute Rule Set Parameter located on the Movement Statistics Parameter form. For your rule set to take affect, you must perform this assignment step.

Define Alternate UOM Rule Set:
Alternate UOM rules permit you to report specific commodity code transactions in a unit of measure other than the default UOM.

Alternate unit of measure rules are used in conjunction with the default Weight UOM. You define a default weight UOM when you set up Movement Statistics Parameters. Every transaction will be reported in the default UOM you have specified.

If your reporting needs require that you report movement transactions in a unit of measure other than the default unit of measure that has been specified, you will have to define one or more alternative UOM in which to report. For example, your default UOM is kilograms. However your movement of goods declaration includes the transportation of diamonds. Instead of reporting diamonds in KG, you want to report them in carats. Using the Movement Statistics Validation Rules form, you would specify an alternate UOM for the commodity code in which diamonds falls.

Note that you define an alternate UOM for a commodity code and not an item.

Note: If you define an Alternate UOM rule set, you must assign the rule set in the Movement Statistics Parameters form.

1. Change the Rule Set Type to Alternate UOM.

2. Assign a rule number.

3. Select a Commodity Code from the LOV.

4. Select a UOM from LOV.

5. Update the Movement Statistics Parameters form with your new Alternate UOM Rule Set.

Using the Call Out Program
The Call Out program enables you to enter your own data values and overwrite any default value for fields in movement statistics records. It works like this: the Movement Statistics Processor ‘calls’ the call out program just before creating a movement statistics record. The data you have provided in the call out program will overwrite the specified data in the movement statistics record. The movement statistics record will then be
created with the values that you specified in the Call Out Program.

**Note:** due to the technical nature of the Call Out Program, it is suggested that you work with your System Administrator when using this feature.

You may use the Call Out Program with the following attributes:

- Transaction Nature
- Delivery Terms
- Statistical Procedure
- Area
- Port
- CSA Code
- Oil Reference
- Container Type
- Flow Indicator
- Affiliation Reference
- Taric Code
- Preference Code

You may not use the Call Out Program with the following attributes:

- Weight
- Quantity
- Monetary Amounts

**Technical Overview**

The Call Out is a package, INV_MGD_MVT_DEF_ATTR, that enables you to overwrite any default value for any attribute of the movement statistics record. It is called by the Movement Statistics Processor before creating a new movement statistics record. The package is shipped with an empty procedure, Default_Attr. You customize the procedure Default_Att by replacing the empty procedure in the package body to introduce logic that allows to overwrite the default.
Using the Call out

The following outlines the procedure for using the Call Out. For the purposes of this example, the field 'Transaction Nature' will be used.

1. Use an editor to update the package 'INV_MGD_MVT_DEF_ATTR.'

2. Insert the value you require by replacing '<replace transaction_nature>' with your value in single quotes.

3. Remove the "--" in the beginning of the line you will be using.

4. Save your work.

Example

In this example, you will use the Call Out to insert the value '10' for Transaction Nature (in every case).

First, locate the line '- - x_transaction_nature:= <replace transaction_nature>;

Second, update this line to read as follows:
'- - x_transaction_nature := '10'

This code will result in the Transaction Nature being set to the value '10' in every movement statistic record created.

Example

In this example, more complex logic is added to modify the value of Transaction Nature. The logic used in this example determines the Transaction Nature value based on a transaction type.

```
SELECT RCV.TRANSACTION_TYPE
INTO l_txn_type
FROM RCV_TRANSACTIONS
WHERE TRANSACTION_ID =
p_movement_transaction.rcv_transaction_id;
IF l_txn_type= 'RECEIVE'
THEN     x_transaction_nature := '11';
ELSIF     l_txn_type = 'RETURN TO VENDOR'
THEN     x_transaction_nature := '40';
ELSE     x_transaction_nature := '99';
END IF;
```

This logic will result in the following:

• If the transaction type is Receive the Transaction Nature is set to '11'

• If the transaction type is Return to Vendor the Transaction Nature is set to '40'

• If the transaction type is not Receive or Return to Vendor the Transaction Nature is set to '99'
Define Additional Economic Zones

You may define additional economic zones, other than the ones provided by Oracle's movement statistics solution.

Using the Economic Zone form, you can define additional economic zones where you conduct business. Once defined, new economic zones work the same as the pre-seeded economic zones.

Economic zones are used for gathering, reviewing, and reporting statistical information associated with material movements within the specified zone. Oracle's movement statistics solution uses this information to determine which material movement transactions take place in a reporting jurisdiction.

If you define new economic zones, you will be required to assign them to a legal entity. Refer to the Movement Statistics Parameters section of this chapter.
Movement Statistics Record Creation

This chapter covers the following topics:

- Movement Statistics Processor Overview
- Movement Statistics Submission Parameters
- Query Movement Statistic Records
- Display Movement Statistics Records
- Find Movement Statistics Window
- Movement Statistics Summary Window- Single Record
- Movement Statistics Summary Window
- Movement Statistics Details Window
- Manual Creation of Movement Statistic Records
- Consigned Receipts and Consigned Returns

Movement Statistics Processor Overview

You run the Movement Statistics Processor to automatically generate movement statistics records. The Movement Statistics Processor analyzes and processes movement transactions from which the movement statistics records are created.

Strategy for Running the Movement Statistics Processor

The schedule that you set up to run the Movement Statistics Processor is determined by the volume of movement transactions. In general, the higher your movement transaction volume, the more often that you should run the processor.

Movement Statistics Transactions

Oracle's movement statistics solution creates movement records for the following
transactions:

- Purchase Receipts - shipment from a supplier, including planned purchase orders and blanket purchase agreements.

- Return to Vendor (RTV) - the return of goods from a specific receipt to the supplying vendor.

- Return Material Authorization (RMA) - immediate adjustment transaction - return of goods against a sales order (may or may not include a credit memo).

- Triangulation - supplier drop shipments.

- Multiple-organization drop shipments - drop shipments that span legal entities.

- Inventory inter-organization movements - the movement of material from one organization to another.

- Internal Requisitions and Internal Sales Orders.

- Standard Sales Orders - the order data as defined or captured by Oracle Order Management.

- Prepayment Invoices - those associated with a specific movement transaction.

- Invoices - only those associated with a specific movement transaction.

- Consigned receipts and returns - creates an arrival record for the consigned receipt and a dispatch record for the consigned return.

- Credit/Debit Memos - those associated with a specific movement transaction.
Movement Statistics Submission Parameters

You submit the Movement Statistics Processor to create movement records. The submission parameters are:

• Legal Entity (required) - select a Legal Entity from the list of values.

• Dates From (required) - select a starting date.

• Dates To (optional) - select an ending date.

• Document Source (optional) - the default is all transaction types for the select Legal Entity and dates. You may also select a specific transaction type (sales order, purchase order, return to vendor, etc.) to process.

Movement Statistics Processor Submission Process:

1. Enter the parameters to run the Movement Statistics Processor.

2. Submit the processor concurrent program for execution.

3. Verify execution of the concurrent program.
4. View the movement statistics records the processor generates.

Query Movement Statistic Records

After you have run the Movement Statistics Processor, you use the Find Movement Statistics window to query and display your movement statistics records.

The Basic Tab on the Find Movement Statistics Form permits you to query based on the following criteria:

- Legal Entity - you may search by Legal Entity
- Economic Zone - you may search by Economic Zone
- Usage Type - you may search by Internal or External
- Statistical Type - you may search for movement records based INTRASTAT, EXTRASTAT
- Inventory Organization - you may search for movement records based on inventory organization you have defined
- Movement Number - if you know the movement number of a specific movement record, you may query using the movement number. You may also validate the movement number: if the Validate box is checked, the search engine will verify that the movement number exists before performing the search.
- Movement Status - you may search for movement records based on their record status (OPEN, VERIFIED, FROZEN, etc.)
- Movement Type - you may search for movement records based on type (Arrival, Dispatch, etc.).

Note that these fields are all optional. You may enter as many search criteria as you wish. If you do not enter any search criteria, all movement records will be displayed.
The Advanced Tab on the Find Movement Statistics form enables you to query based on the following criteria (in conjunction with the criteria you may have entered on the Basic Tab):

- **Source Type** - you may search by transaction type (sales order, purchase order, etc.)
- **Period Name** - you may search by specific period
- **Dates From** - you may search by a date range
- **Date To** - you may search by a date range
- **Document Number** - you may search by sales order or purchase order number. You must know the specific sales or purchase order number. Note that you must select a Source Type if you plan to search by Document Number.
- **Transaction Number** - you may search by All, Receipt, Delivery, Requisition, or Transaction ID.
- **Invoice Number** - you may search by payable or receivable invoice number. You must know the specific invoice number. Note that you must select a Source Type if you plan to search by Invoice Number.
- **Commodity Code** - you may search by Commodity Code. You may select a commodity code from a list of values. Note that you must enter a Legal Entity, Economic Zone, Usage Type, and Statistical Type on the Basic Tab form if you plan to search by Commodity Code.
- **Destination Country** - you may search by Destination Country. You select a Destination Country from a list of values.
• Transaction Code - you may search by Transaction Nature. You select a Transaction Nature from a list of values.

• Report Reference - you may search by Report Reference. A Report Reference Number is generated by the Movement Statistics Official Summary Report. Only movement records that have been listed on the Official Summary Report will have a Report Reference Number.

• Dispatch Country - you may search by Dispatch Country. You select a Dispatch Country from a list of values.

• Delivery Terms - you may search by Delivery Terms. You select a Delivery Terms from a list of values.

• Transport Mode - you may search by Transport Mode. You select a Transport Mode from a list of values.

Note that these fields are all optional. You may enter as many search criteria as you wish. If you do not enter any search criteria, all movement records will be displayed.

Find Movement Statistics Records Process:
1. Enter the parameters to find movement statistics records using the Basic window.
   
   Note: If you do not enter any parameters, the system displays all movement statistics records.

2. Enter the parameters to find movement statistics records using the advanced window.

3. Find and display the records based on the parameters you entered.

4. To stop the query click Cancel and close the find movement Statistics window.

5. Click Clear to empty the parameters you entered.

Display Movement Statistics Records
The following forms are used to display and modify movement statistics records that result from your query:

• Find Movement Statistics - displays results (you may not modify records on this form)

• Movement Statistics Summary - Single Record - displays results (you may not modify records on this form)
• Movement Statistics Summary - displays results (you may not modify records on this form)

• Movement Statistics Details - the only form on which you may modify a movement record

Find Movement Statistics Window

Use the Find Movement Statistics form to both enter your query search criteria and to display the results of your query. This form will display all the records retrieved based on the search criteria. All records found as a result of the query will be displayed on the bottom of this form. Movement statistic records displayed here may not be updated on this form.

Find Movement Statistics Window - Results

To save a query for future use:
1. Enter your query criteria, and click Find.
2. Click Save As (from the Find Movement Statistics form) to display the Save As window. Click Save to save the current query.
3. Enter a New Folder Name – this will be the name of your saved query. The current query and parameters will be saved.

4. Click Save.

5. Run a saved query from the Movement Statistics Summary form.

**To run a saved query:**

You can run a saved query from the Movement Statistics Summary form.

1. Select Personal Shortcuts from the Movement Statistics Summary form. All previously saved queries will be displayed.

2. Click the + key to expand the tree structure and display the movement ID of the records retrieved by the query in groups of ten. Click Next to retrieve the next ten records.

3. Click the saved query to execute the query and populate the Movement Statistics Summary form.

4. Click the - key to collapse the tree structure.
**Movement Statistics Summary Window - Single Record**

You can display an individual movement record summary from the Find Movement Statistics form after you have performed a query. Movement statistic records may not be updated on this form.

To display a record in this format, first query the record on the Find Movement Statistics form, then *double click* the record to display its details. To return to the complete listing of all records found based on the query, click Movement (highlighted in blue) located on the left hand column of the form.

**Individual Summary Window**

A navigational Tree Structure, located on the left side of the Movement Statistics Summary form, is available for your use. To expand or collapse the tree structure, click the plus or minus.

**Movement Statistics Summary Window**

The Movement Statistics Summary form displays all the records from a query in summary format. This form includes a Query Tree Structure to help you to save and organize frequently used queries. Movement statistic records may not be updated on this form.

The Detail button displays detailed information about a single Movement Statistics
record you have selected.

Movement Statistics Summary Form

The Movement Statistics Details window displays one movement statistics record in detail format. The only way to access the Details window is via the Movement Statistics Summary window. To display a movement record on the Detail window, you must click Detail found on the Movement Statistics Summary window.

The Movement Statistics Details window is divided into a header section and six sections or tabs as follows:

- Movement Details
- Country Details
- Source Details
- Invoice Details
- Additional Details
- Miscellaneous

Fields in the header section may not be modified. Specific fields in each of the tabbed
sections may be updated as required. This is the only form where you may update movement statistic records.

Much of the information displayed on the Movement Statistics Details form is also displayed on the Movement Statistics Standard Detail Report. If you do not want to make modifications to movement records and review the information only, you may want to print this report.

**Movement Statistics Details Window - Movement Details Tab**

The Movement Details window displays and permits modification of movement transaction details, including item, quantity, price, and weight information. Refer to the Appendix for detailed information about each field displayed on the Movement Details form.

**Movement Statistics Details Window**

![Movement Statistics Details Window](image)

**Movement Statistics Details Window - Country Details Tab**

The Country Details window displays and permits modification of the countries involved in the transaction. Refer to the Appendix for detailed information about each field displayed on the Movement Country Details window.
The Source Details window displays information about the transaction source. Each Source Type will result in different information, appropriate to the transaction type, being displayed. Refer to the Appendix for detailed information about the fields being displayed on this form. Note that you may not modify any of the information on this window.

**Source Type and Display**

- Sales Orders
- Sales Order Number
- Sales Order Line
- Process Organization
- Delivery Name
- Customer Name, Number, and Site

**Purchase Orders**

- Purchase Order Number
Release Number
Purchase Order Line
Receipt Number
Process Organization
Supplier Name, Number, and Site

Inventory Transactions

Process Organization
Transaction ID
From Organization
To Organization

Movement Statistics Details - Source Details Tab

The Invoice Details window will display invoice information if the Source Type has been invoiced. You may not modify information on this form. Refer to the Appendix for detailed information about each field displayed on the Invoice Details window.

Movement Statistics Details Window - Invoice Details Tab
**Movement Statistics Details Window - Invoice Details Tab**

The Additional Details window will display and permit modification of additional movement details, including making adjustments. Note that the adjustments will be listed on the Movement Statistics Reports. Refer to the Appendix for detailed information about each field displayed on the Additional Details window.
Movement Statistics Details Window - Miscellaneous Tab

The Additional Details window will display and enables modification of miscellaneous movement information. Refer to the Appendix for detailed information about each field displayed on the Miscellaneous window.
Manual Creation of Movement Statistic Records

Oracle's movement statistics solution also gives you the capability to create movement records manually. You may create a manual movement record to adjust an existing transaction or to account for a new transaction.

You may create movement records for the following transactions manually:

- Inter Organization Transfer
- Delivery
- Receipt
- Miscellaneous

To create movement records manually, you must have one of the following forms open:

- Movement Statistics Summary form
- Movement Statistics Detail form.

From one of these forms, you open the Transaction Types window to start the manual record creation process.
Once you have successfully entered the manual record, you may query, modify, and report the record as you would a record created by the Movement Statistics Processor.

**Movement Statistic Summary Window - Manual Record Entry**

1. Open one of the following windows:
   - Movement Statistics Details
   - Movement Statistics Summary

2. Select File > New to display the Transaction Types window.

3. Enter the Legal Entity.

4. Select the transaction type of the manual record to create from the list of values.

5. If necessary, enter the inventory organization.

6. Select and enter the fourth field based on the Transaction Type.

7. Click OK to display the Movement Statistics Details window. Enter the required movement information.

**Manual Movement Statistics Record Creation Process:**

1. Open one of the following windows:
   - Movement Statistics Details
   - Movement Statistics Summary

2. Select File > New to display the Transaction Types window.

3. Enter the Legal Entity.

4. Select the transaction type of the manual record to create from the list of values.

5. If necessary, enter the inventory organization.

6. Select and enter the fourth field based on the Transaction Type.

7. Click OK to display the Movement Statistics Details window. Enter the required movement information.
Note: You cannot save the manual record until you enter all required fields.

8. Select Validate to validate the record.

Consigned Receipts and Consigned Returns

To comply with European Union legislation, European customers typically must include movements of consigned goods in their Intrastat and Extrastat monthly declarations. To track movements of consigned goods, the Oracle movement statistics processor creates arrival records (for consigned receipts) and dispatch records (for consigned returns), and assigns a corresponding transaction code to help you identify the record for reporting purposes (see the appendix for an official EU list of transaction codes).

For consigned receipts, although the actual ownership of the goods is not transferred, the movement statistics processor must create a record for the consigned receipts against the month when the receipt occurred. Since the value of the goods must correspond to an amount which would have been invoiced if the goods were sold or purchased, the movement statistics processor must populate the Value field with an estimated purchase price. Returns to Supplier (RTV) from consigned inventory are evaluated in the same way as regular returns.

For example, suppose that in May, consigned goods are received and delivered into stock by a buyer (an Oracle customer) in one EU member state from a supplier in another EU member state. Since the goods still remain the property of the seller, the transfer of ownership does not occur when the goods are received. Although no sale has occurred, the buyer must declare the goods as an arrival in his Intrastat declaration (for May), and state an amount which would have been invoiced had these goods been sold or purchased. The arrival record must be identified by the appropriate transaction code which identifies both Intrastat and Extrastat Arrivals, and Dispatches. The code values are defined in the Nature of Transaction Code lookup value.

Arrival and dispatch records based on consigned transactions can be created both automatically or manually as described in the following steps:

To automatically create consigned arrivals:
1. Enter a standard purchase order for consigned goods.
2. Receive the consigned shipment.
3. Run the Movement Statistics Processor concurrent program selecting Source Type = Purchase Order.
4. Query the records generated from the Find Movement Statistics Form by entering
the following criteria:

- Legal Entity
- Economic Zone

- Movement Type: Arrival, and/or
- Source Type: Purchase Order and
- Document Type: Purchase Order No or Receipt Order Number

An arrival record with Transaction code = 12 is created for consigned receipts.


**To automatically create consigned returns:**

1. Enter Return to Vendor transaction for the consigned goods.

2. Run the Movement Statistics Processor concurrent program (selecting Source Type = Return to Vendor).

3. Query the records generated from the Find Movement Statistics form by entering the following criteria:

- Legal Entity
- Economic Zone
- Movement Type: Dispatch, and/or
- Source Type: Purchase Order and
- Document Type: Purchase Order No or Receipt Order Number

A dispatch record with Transaction code = 21 is created for consigned returns.


**To manually create consigned receipts:**

1. Enter a standard purchase order for consigned goods.

2. Receive the consigned shipment.

3. Open either the Movement Statistics Details form or the Movement Statistics
4. Select File > New from the toolbar to display the Transaction Types window. Complete your entries:

- Select the Legal Entity (mandatory).
- Transaction Type:
- Select the Receipt Number.
- Select the Inventory Organization.

5. Click OK to display the Movement Statistics Details form. Update the movement information if necessary.

Note: You will not be able to save the manual record until all required fields have been entered. The status of the record will be Open when you save it.

6. Select Tools > Validate to validate the manual record against the validation rule set and for system validation. After you validate the record, the status of the record will be Verified.

7. Continue the movement statistics standard reporting procedure by running the Movement Statistics Report concurrent program.

To manually create consigned returns:

1. Enter a Return to Vendor transaction for the consigned goods.

2. Open either the Movement Statistics Details form or the Movement Statistics Summary form.

3. Select File > New from the toolbar to display the Transaction Types window. Complete your entries:

- Select the Legal Entity (mandatory).
- Transaction Type:
- Select the Receipt Number.
- Select the Inventory Organization.

4. Click OK to display the Movement Statistics Details form. Update the movement
information if necessary.

**Note:** You will not be able to save the manual record until all required fields have been entered. The status of the record will be *Open* when you save it.

5. Select Tools > Validate to validate the manual record against the validation rule set and for system validation. After you validate the record, the status of the record will be *Verified*.

This chapter covers the following topics:

- Exception Report Overview
- Exception Report and Validation Rules
- Record Verification
- Correcting Movement Statistics Exceptions
- Movement Statistics Ignore Record Status

**Exception Report Overview**

The Movement Statistics Exception Report does the following tasks when it is run:

1. Validates movement records.
2. Identifies movement records that had exceptions and warnings.
3. Generates the Exception Report that lists both exceptions and warnings.
4. Updates the status of a movement statistics record from OPEN to VERIFIED for all records that have no exceptions.
5. Creates adjustment records for both arrival and dispatch adjustment records.

**Validation of Movement Statistics Records**

The Movement Statistics Exception Report verifies movement statistics records against validation rule sets. You may use either the pre-seeded Standard_Validation Rule Set or define your own rule set (see Adaptation of Movement Statistics to Local Requirements). The Exception report validates movement statistics records against the selected validation rule set and the system default validations.

The validation performed by the Exception Report includes:
1. Identifying exceptions. Exceptions in a movement statistics record prevent you from declaring that record. You can then correct the record in order to meet reporting requirements.

2. Identifying warnings. Warnings in a movement statistics record do not prevent the user from declaring that record, they are for informational use only. Records with warnings only may be used in a declaration.

**Reporting of Exceptions**

Exceptions in a movement statistics record prevent you from declaring that record. The Exception Report is used to help you make timely and complete movement statistics declarations to the proper authorities.

The Movement Statistics Exception Report generates a listing of every movement statistics record with an exception or a warning.

You select which movement statistics records to validate with your selection of input parameters for the Movement Statistics Exception Report. The input parameters you select determines which records will be validated against the validation rules.

**Record Status Update**

The Exception Report will update the status of all records that do not have any exceptions to VERIFIED. The status of records with warnings only will also be updated to VERIFIED.

The status of movement transactions that have exceptions will remain as OPEN. Before a movement record’s status can be updated to VERIFIED, all exceptions for that record must be corrected. Note that a movement transaction can not be reported to government agencies, nor can the Movement Statistics Official Summary Report run, while any movement transaction record status remains OPEN within a reporting period.

**Note:** Records with a status of IGNORE will not be updated to VERIFIED by the Exception Report.

**Create Adjustment Records**

The Movement Statistics Exception Report will automatically create the following adjustment records:

1. Arrival Adjustment Records. This record type will be created when all the following conditions are met:
   - the arrival record was not invoiced in the reporting period in which it was created
• the arrival record is invoiced, but in a later reporting period
• the status of the arrival record is FROZEN
• the reporting period in which the arrival record was created is closed

2. Dispatch Adjustment Records. This record type will be created when all the following conditions are met:
• the dispatch record was not invoiced in the reporting period in which it was created
• the dispatch record is invoiced, but in a later reporting period
• the status of the dispatch record is FROZEN
• the reporting period in which the dispatch record was created is closed

If these conditions are met, a new arrival or dispatch record will be created. The status of the newly created adjustment record will be open. You will be required to verify and declare the record for the period in which it was created. Note that the original record will not be modified and status of the original record will remain frozen.

**Exception Report and Validation Rules**

The Movement Statistics Exception Report validates the movement transactions against the validation rule sets, either the pre-seeded Standard Validation Rule Set or a rule set defined by the user and the system default validations.

**Standard Validation Rule Set**

If you are using the pre-seeded Standard Validation Rule Set the following data will validated and an exception listed if this date is missing or incorrect:

- Transaction Code
- Transportation Mode

**Exception report and the system Default Validations**

The Exception Report will validate the following fields against the system default validations and an exception listed if the following fields are missing:

1. Commodity Code
2. Unit Weight
3. Exchange Rate

Exception Report and Warning Messages
Any record that is missing an invoice (that is, a transaction that has not been invoiced) will be listed as a warning on the Exception Report. A warning message will not prevent a record from being declared – the Missing Invoice warning message is informational only. Records with warnings only (and no exceptions) may be used in a declaration. Also, the status of records with warnings only will be updated to verified.

Exception Report and User Defined Validation Rules
You may define your own validation rules sets (refer to the Movement Statistics Validation Rules section of this guide). All records that fail user defined validations will be listed on the Exception Report.

Record Verification
You may validate movement records either:
1. Automatically
2. Manually

It is suggested that you verify records automatically first, before attempting to manually verify records.

Automatic Record Verification
You can run the Movement Statistics Exception Report to automatically verify and update the status of movement records for a specified period. Only records without exceptions will be updated. Records with exceptions will have to be corrected manually.

The movement statistics record verification process flow when using the Exceptions Report is as follows:
1. Run Movement Statistics Exception Report
   Enter the parameters to run the exception report.

2. Review Exception Report
   Review the Exception Report.

3. Correct Exceptions
   Return to the Movement Statistics Details form and make the necessary correction(s).
4. Rerun the Movement Statistics Exception report
   Rerun the Exception Report after you have corrected all exceptions.

5. Review Exception Report
   Review the Exception Report and verify all exceptions have been corrected.

**Manual Validation**

You may also validate records on-line instead of running the Exception Report. Use the Movement Statistics Detail form to perform the validation manually. Only records with a status of open may be validated.

*Note:* On-line validation of movement records use the same validation rules used in the Exception Report.

1. Query for Open records.
   Query all movement records with a status of Open for a given period.

2. Select a record from the Movement Statistics Summary form.
   Select a movement record to validate from the Summary form.

3. Open the record.
   Open record in the Movement Statistics Detail form

4. Using the Tool Bar, select: Tools > Validate.
   The record will be validated and all exceptions and warnings will be displayed on line.

5. Correct Exceptions.
   Correct exceptions on-line and save the record. Note that you will only be able to save a record with the exceptions corrected. You can not save invalid data.

6. Record status is updated.
   If the record has no exception or if you have corrected all exceptions, the status of the record will be updated to Verified.

**Correcting Movement Statistics Exceptions**

This section reviews the exceptions listed on the Movement Statistics Exception Report and how to correct them. The exceptions reviews are based on the Standard Validation Rule Set and the system default validations. If you are using your own user defined
validation rule set, the exceptions listed on the report may be different.

The Exception Report lists all movement statistics records with the following exceptions (based on the Standard Validation Rule Set):

1. Transaction Code
2. Transportation Mode

The Exception Report lists all movement statistics records with the following exceptions (based on system default validation):

1. Commodity Code
2. Unit Weight
3. Exchange Rate
4. Invoice

**Correcting Exceptions Process**

This section reviews the exception correcting process. This process may be used to correct any exception listed in the Exception Report.

1. Using the Movement Id listed on the Movement Statistics Exceptions Report, query the record using the Movement Statistics Detail form (on-line).
2. From the Toolbar on the Movement Statistic Detail form, select Tools > Validate. This will list all exceptions with the record. You may correct the records on line. Note that until all exceptions are corrected, the status will remain open.

**Standard Validation Rule Exceptions**

This section reviews the exceptions generated by the Standard_Validation Rule Set.

**Transaction Code**

If the Transaction Code is missing, the following exception message will be displayed:

**Missing Value Transaction Code**

If the Transaction Code is incorrect, the following exception message will be displayed (refer to the Appendix for a listing of valid Transaction Codes):

- Incorrect Value: Transaction Code
Transportation Mode

If the Transaction Mode is missing, the following exception message will be displayed:
• Missing Value: Transportation Mode

If the Transaction Code is incorrect, the following exception message will be displayed (refer to the Appendix for a listing of valid Transaction Codes):
• Incorrect Value: Transportation Mode

Default System Validation Exceptions

This section reviews the exceptions generated by the default system validations. Note that the default system validation determines if a required field is present and not if the actual value is correct.

Commodity Code

If the Commodity Code is missing, the following exception message will be displayed:
• Missing Value: Commodity Code

To correct this exception, the good that you are transacting must have been assigned a commodity code (refer to the Commodity Codes using Category Sets section of this guide).

Unit Weight

If the Unit Weight is missing, the following exception message will be displayed:
• Missing Value: Unit Weight

To correct this exception, the goods that you are transacting must have been assigned a unit weight (refer to the Miscellaneous Setup section of this guide).

Exchange Rate

If the Exchange Rate is missing, the following exception message will be displayed:
• Missing Value: Exchange Rate

To correct this exception, an exchange rate between the functional currency and the transaction currency must be setup.

Invoice

If the Invoice is missing, the following exception message will be displayed:
• Missing Value: Invoice_ID
Note that all records that are missing an Invoice (that is, a transaction that has not been invoiced) will also be listed on the exception report. This exception will not prevent a record from being verified – the Missing Invoice exception is informational ONLY.

User Defined Validation Rules

This section review the most common errors encountered when using user defined validation rules (instead of the Standard_Validation Rule Set).

Exceptions Not Listed on Exception Report

You expected to see an exception based on the validation rule that you set up, but the exception is not listed on the Exception Report.

The most common cause for this problem is that the validation rule set has not been set up properly. Refer to the ‘Adaptation of Oracle Movement Statistics to Local Requirements’ section of this guide.

Verify the following for your user defined validation rule set:

1. your validation rule set has been saved on the Movement Statistics Parameters form in the Attribute Rule Set Code field. If it has not, enter your validation rule set and save it.

2. the Attributes in your validation rule set have an Attribute Property of either Required - Updateable or Required - Not Updateable. The Exception Report will only list exceptions for fields that have an Attribute Property of Required - Updateable or Required / Non-Updateable.

Movement Statistics Ignore Record Status

The purpose of the IGNORE record status is to enable you to:

• remove a record from further processing and reporting, either permanently or temporarily

Only a movement record with a status of OPEN or VERIFIED may be updated to IGNORE. Once the status of a record has been updated to IGNORE, the Movement Statistics Processor will no longer process the record, nor will the record be reported on any Movement Statistics Report. Movement records will remain in status of IGNORE unless they are updated on-line or by running the Movement Statistics Reset Status concurrent program.

Once a movement statistic record’s status is set to IGNORE the record will not be processed by any of the following processors and concurrent programs:

• Movement Statistics Exception Report

• Movement Statistics Processor
• Movement Statistics Data Export File

• e-Commerce Gateway

• Movement Statistics Official Summary

Once a movement statistic record’s status is set to IGNORE the record will not be reported by any of the following reports:

• Movement Statistics Official Summary

• Movement Statistics Standard Summary

• Movement Statistics Standard Detail

Setting Ignore Status

The only way to set the status of a movement record to IGNORE is on-line, and on an individual record by record basis, using the Movement Statistics Details form. Only records with a status of OPEN and VERIFIED may be updated to IGNORE.

1. Find the movement record to update using the Find Movement Statistics form.

2. Navigate to the Movement Statistics Details form.

3. From the Movement Statistics Details form, using the Toolbar select: Tools > Ignore.

4. From the drop down menu, Click Ignore to update the status of the movement record.

You have to update the status of each movement record in this manner. There is no automated facility such as a concurrent program to mass update the status of many movement records.
Setting the IGNORE status

You can update the status of a movement record from IGNORE to OPEN in one of two ways:

1. Using the Movement Statistics Details form.

Note: Records with a status of IGNORE can only be updated to a status of OPEN.

To Update the Status from Ignore to Open:

1. Find the movement record to update using the Find Movement Statistics form.
2. Navigate to the Movement Statistics Details form.
3. From the Movement Statistics Details form, using the Toolbar select: Tools > Open.
4. From the drop down menu, Click Open to update the status of the movement record.

**Using the Movement Statistics Reset Status Concurrent Program**

You can use the Movement Statistics Reset Status concurrent program to mass update the status of a number of movement records from IGNORE to OPEN.

Note that the Reset Status concurrent program will, by default, update ALL records for a specified Legal Entity and period to OPEN status. If you only want to update movement records with a status of IGNORE to OPEN, you must specify the correct Reset Option parameter before running this concurrent program.

**Re-Setting Ignore Status**

You can update the status of movement record from IGNORE to OPEN on a record by record basis using the Movement Statistics Details form.

**To update the status of movement records using the Movement Statistics Reset Status concurrent program:**

1. Navigate to the Movement Statistics Reset Status concurrent program.

2. Enter the following parameters to execute the Reset Status concurrent program:
   - Legal Entity
   - Economic Zone
   - Usage Type
   - Statistical Type
   - Period Name
   - Document Source
   - Reset Option

3. You may set the Reset Option parameter as follows:
   - Blank – all movement records as specified by the previous parameters will be updated to OPEN
   - All – the same as leaving the parameter blank, all movement records as specified by the previous parameters will be updated to OPEN
   - Exclude Ignore – the status of all movement records specified by the parameters
will be updated to OPEN except those records with IGNORE status

- Ignore Only -- the status of all movement records with status of IGNORE as specified by the parameters will be updated to OPEN. A record with any other status will not be updated to OPEN

**Movement Statistics - Reset Option**

![Image of Movement Statistics - Reset Option interface](image.png)
Movement Statistics Reports

This chapter covers the following topics:

- Movement Statistics Reports
- Movement Statistics Standard Reports
- Movement Statistics Report Submission Process

Movement Statistics Reports

Use the Movement Statistics Reports to review all movements records during a specified period.

There are two reports available for this purpose:

- Standard Summary
- Standard Detail

These reports are not intended for making legal movement statistics declarations. Rather, the reports are a comprehensive summary of all movement statistics data for a given period. The reports should be used to check the movement statistics records before making a legal declaration.

To obtain country specific reports for the purpose of making legal declarations, you will have to design and create reports according to local rules and requirements. Alternatively, you may choose to make you movement statistics declarations electronically.

Related Topics

Movement Statistics Declarations, page 6-1
Movement Statistics Standard Reports

The transaction summary reports available with Oracle Movement Statistics are:

Summary Report

The Summary Report lists a single summary line for each movement statistics record. Use this report to verify that the transaction data is correct.

Please refer to the Appendix for a complete listing of the fields displayed on the reports as well as examples of the Summary and Detail Reports.

**Note:** Records with a status of IGNORE will not be listed on the Summary Report.

Detail Report

The Detail Report displays comprehensive information for each movement statistics record. This report may also be used verify that the transaction data is correct. Note that depending on the number of movement transactions you are reporting for the period, this report may be quite large.

Please refer to the Appendix for a complete listing of the fields displayed on the reports as well as examples of the Summary and Detail Reports.

**Note:** Records with a status of IGNORE will not be listed on the Detail Report.

### Report Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Possible Values</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legal Entity</td>
<td>Any valid legal entity</td>
<td>Select the legal entity to make the declaration for.</td>
</tr>
<tr>
<td>Economic Zone</td>
<td>Any valid economic zone</td>
<td>Select the economic zone to make the declaration for.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Possible Values</td>
<td>Comments</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Usage Type</td>
<td>Internal</td>
<td>Internal - movement of goods within countries of the economic zone</td>
</tr>
<tr>
<td></td>
<td>External</td>
<td>External - movement of goods from the economic zone to / from countries outside the economic zone</td>
</tr>
<tr>
<td>Statistical Type</td>
<td>INTRASTAT</td>
<td>Intrastat - movement statistics from within the European Union</td>
</tr>
<tr>
<td></td>
<td>EXTRASTAT</td>
<td>Extrastat - movement statistics from within the economic to / from countries outside the economic zone</td>
</tr>
<tr>
<td>Movement Type</td>
<td>Arrival</td>
<td>Arrival - report on all arrival movement statistics – receipt of goods transactions into an economic zone countries</td>
</tr>
<tr>
<td></td>
<td>Arrival Adjustment</td>
<td>Arrival Adjustment - report on all adjustments to prior period arrival movement statistics</td>
</tr>
<tr>
<td></td>
<td>Dispatch</td>
<td>Dispatch - report on all dispatch movement statistics – shipment / movement of goods from economic zone countries</td>
</tr>
<tr>
<td></td>
<td>Dispatch Adjustment</td>
<td>Dispatch Adjustment - report on all adjustments to prior period dispatch movement statistics</td>
</tr>
<tr>
<td>Period Name</td>
<td>Any valid period</td>
<td>Select the period to make the declaration for.</td>
</tr>
<tr>
<td>Report Option</td>
<td>Standard Summary</td>
<td>Select the report to generate.</td>
</tr>
<tr>
<td></td>
<td>Standard Detail</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Possible Values</td>
<td>Comments</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Currency</td>
<td>Valid currency</td>
<td>The currency defaults from the set of books currency.</td>
</tr>
<tr>
<td>Exchange Rate</td>
<td>Valid exchange rate</td>
<td>Select the exchange rate from the LOV.</td>
</tr>
</tbody>
</table>

**Movement Statistics Report Submission Window**

![Movement Statistics Report Submission Window](image)

**Create Adjustment Movement Records Error Report**

This report automatically creates adjustment movement that report adjustments to previously declared records. This report creates:

- Arrival adjustment movement records to adjust the invoice information of a previously declared arrival movement record.

- Dispatch adjustment movement records to adjust invoice information of a previously declared dispatch movement record.
Movement Statistics Exception Report

The Movement Statistics Exception Report displays exceptions resulting from user-defined validation rule sets. However, only those attributes with an attribute property of Required, Updateable, or Required, Not Updateable, can be displayed by the Movement Statistics Exception Report.

If a movement statistics record is missing one of the attributes defined in the validation set and the attribute property is Required, Updateable, or Required, Not Updateable, then the report displays one or more of the following messages:

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Movement ID</td>
<td>The Movement ID is missing.</td>
</tr>
<tr>
<td>Error</td>
<td>Missing or incorrect value.</td>
</tr>
<tr>
<td>User Action</td>
<td>Enter or correct the value.</td>
</tr>
</tbody>
</table>

Movement Statistics Report Submission Process

1. Enter the parameters to identify the movement statistics report to run.
   
   **Note:** All movement statistics reports are submitted from the same window using different parameters.

2. Submit the program for execution.

3. Display and view report output.
This chapter covers the following topics:

- Declaration Process
- Paper Based Movement Statistics Declarations
- Create Country Specific Reports
- Electronic Based Movement Statistics Declarations
- Overview: Electronic Based Declarations
- e-Commerce Gateway
- Creating Export Data File
- Troubleshooting

Declaration Process

Once you have verified the transaction data, you are ready to transmit the movement statistics declaration to the proper government agencies. Note that Oracle’s movement statistics solution does not provide for country-specific reporting. Using Oracle’s movement statistic solution, you may make your legal movement statistics declaration either using paper-based reporting or by electronic (EDI, IDEP, or other third party product) based reporting.

The Declaration Process

1. Determine Declaration Requirements.


3. Transmit Declaration.

Determine Declaration Requirements

Every country requiring movement statistics declarations has different reporting
requirements. These country specific requirements include report formats, reporting amount thresholds, level of detail, quantities, reporting periods, etc. You should familiarize yourself with the reporting and transmission requirements of your country to be in compliance with declaration regulations.

**Run Official Report**

Run the Movement Statistics Official Report to update the status of all movement statistics records for the period specified to FROZEN. The status of all movement statistics records that you are planning to declare must be FROZEN.

*Note:* All movement records you plan to declare must have a status of FROZEN, whether you are using paper based reporting or not. The only way to update a movement record status to FROZEN is by running the Official Summary Report.

**Transmit Declaration**

You may transmit your movement statistics declaration using any of the following methods. It is up to you to determine which transmission methods meets your needs and your country’s declaration requirements.

**Transmit Declaration via Paper Based Report**

You may make movement statistics declarations via paper based report. Oracle's movement statistics solution supports making paper based declarations with the Movement Statistics Official Summary Report. Transmission of the declaration may be via fax or mail.

**Transmit Declaration via EDI**

Legal movement statistics declarations may be made via EDI. You need to determine if the government agency is capable of receiving EDI transmissions. Oracle's movement statistics solution supports making declarations via EDI with Oracle e-Commerce Gateway.

**Transmit Declaration via Third Party Product**

You may transmit your declaration via any third party product. You need to determine if the government agency accepts the transmission method and format of the third party product.

**Paper Based Movement Statistics Declarations**

You may choose to make your movement statistics declaration via paper based reporting. This section will briefly review the paper based reporting methods supported
by Oracle’s movement statistics solution.

Note that each country has their own format and reporting requirements. You need to familiarize yourself with the format, content of reports as well as the acceptable transmission methods for your country.

The following is a list of paper based reporting methods for movement statistics declarations:


2. Create Custom Country Specific Reports

**Movement Statistics Official Summary Report**

The format of the Official Report is the same as the Summary report, that is one line of detail per movement record. You may, if this report satisfies country specific reporting requirements, submit this report to the proper government agency. However, if this report does not satisfy the reporting requirements of your country, you will need to create the necessary reports acceptable to your government agency.

Please refer to the Appendix for a complete listing of the fields displayed on this report.

**Report Parameters**

The Official Summary Report submission report parameters:

**Official Summary Report Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Possible Values</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legal Entity</td>
<td>Any valid legal entity</td>
<td>Select the legal entity for which you want to make the declaration.</td>
</tr>
<tr>
<td>Economic Zone</td>
<td>Any valid economic zone</td>
<td>Select the economic zone for which you want to make the declaration.</td>
</tr>
<tr>
<td>Usage Type</td>
<td>Internal, External</td>
<td>Internal - movement of goods within countries of the economic zone</td>
</tr>
<tr>
<td></td>
<td></td>
<td>External - movement of goods from the economic zone to / from countries outside the economic zone</td>
</tr>
<tr>
<td>Parameter</td>
<td>Possible Values</td>
<td>Comments</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Statistical Type</td>
<td>Intrastat</td>
<td>Intrastat - movement statistics from within the European Union</td>
</tr>
<tr>
<td></td>
<td>Extrastat</td>
<td>Extrastat - movement statistics from within the economic to / from countries outside the economic zone</td>
</tr>
<tr>
<td>Movement Type</td>
<td>Arrival</td>
<td>Arrival - report on all arrival movement statistics – receipt of goods transactions into an economic zone countries</td>
</tr>
<tr>
<td></td>
<td>Arrival Adjustment</td>
<td>Arrival Adjustment - report on all adjustments to prior period arrival movement statistics</td>
</tr>
<tr>
<td></td>
<td>Dispatch</td>
<td>Dispatch - report on all dispatch movement statistics – shipment / movement of goods from economic zone countries</td>
</tr>
<tr>
<td></td>
<td>Dispatch Adjustment</td>
<td>Dispatch Adjustment - report on all adjustments to prior period dispatch movement statistics</td>
</tr>
<tr>
<td>Period Name</td>
<td>Any valid period</td>
<td>Select the period for which you want to make the declaration.</td>
</tr>
<tr>
<td>Report Option</td>
<td>Official Summary</td>
<td>Select the 'Official Summary' report option.</td>
</tr>
<tr>
<td>Currency</td>
<td>Valid currency</td>
<td>The currency defaults from the set of books currency.</td>
</tr>
<tr>
<td>Exchange Rate</td>
<td>Valid exchange rate</td>
<td>Select the exchange rate from the LOV.</td>
</tr>
</tbody>
</table>
**Movement Statistics Report Submission Process**

1. Enter the parameters to identify the Movement Statistics Report to run

   **Note:** All Movement Statistics Reports are submitted from the same window using different parameters

2. Submit the report concurrent program

3. Display and view report output

   **Note:** Refer to the Appendix for an example of the Movement Statistics Official Summary Report.

**Transmission Methods**

You may transmit paper based declarations via either fax or mail. Verify the transmission methods accepted your country.

**Create Country Specific Reports**

You may create your own country specific reports to fulfill your country’s declaration requirements. To do this, you will be required to use a report generating tool.

The following is the process for creating your own country specific reports:

1. Determine the reporting requirements for your country.

2. Determine a reporting tool you will use to create the report.

3. Design and create your report.

**Determine Reporting Requirements**

Each country may require their own specific format and reporting requirements. You will need to familiarize yourself with report format, report content requirements and transmission methods for each country.

**Determine a Reporting Tool**

To create a custom report, you should make use of a reporting tool. The reporting tool will enable you to select the information and format it to meet your country’s declaration requirements.
Once you have selected a report generating tool, design and create your report. Oracle's movement statistics solution provides all the necessary data from which you can generate your declaration report.

Electronic Based Movement Statistics Declarations

To simplify the reporting of movement statistics declarations, many governments are making it possible to submit via electronic means. This section will briefly review the major electronic transmission methods supported by Oracle's Movement Statistics solution.

Note that each country has their own format and reporting requirements. You need to familiarize yourself with report format, content of reports as well as the acceptable transmission methods for your country.

This section will review:

- Overview: Electronic Based Declarations
- Using Oracle e-Commerce Gateway
- Creating Export Data File

Overview: Electronic Based Declarations

The following is a list of commonly used transmission methods for movement statistics declarations. Most countries require one of the following format types for movement statistics declarations. You should verify which format type is required.

- EDI - Electronic Data Interchange including EDIFACT / CUSDEC / INSTAT
- IDEP / CN8 - Intrastat Data Entry Package / Combined Nomenclature 8 Digit
- ASCII file

EDI

Electronic Data Interchange (EDI) is the electronic exchange of routine business transactions. These transactions include such documents as purchase orders, invoices, inquiries, planning, acknowledgements, pricing, order status, scheduling, test results, shipping and receiving, payments, and financial reporting.

The subsets of EDI used to transmit movement statistics declarations include:

- EDIFACT
• CUSDEC / INSTAT

Note that EDI or any of its subsets including EDIFACT / CUSDEC INSTAT may be transmitted via network, diskette, tape, or as an e-mail attachment.

EDI FACT

Electronic Interchange For Administration, Commerce and Transport (EDIFACT) is a set of internationally agreed standards, directories, and guidelines for the electronic interchange of structured data, and in particular that related to trade in goods and services between independent, computerized information systems. The EDIFACT standard provides a common documentation and a single, unifying business language for communicating across borders.

CUSDEC / INSTAT

CUSDEC / INSTAT is the movement statistics subset message of CUSDEC used for intercommunity (EC) movement statistics declarations. This messages is automatically generated by the IDEP / CN8 software.

Customs Declaration Message (CUSDEC) permits the transfer of data from a declarant to a customs administration for the purpose of meeting legislative and/or operational requirements in respect of the declaration of goods for import, export, or transit. The message may also be used, for example:

• to transmit data from an exporter in one country to an importer in another country.

• to transmit consignment data from one customs administration to another.

• to transmit data from a customs authority to other governments agencies and/or interested administrations.

• to transmit data from a declarant to the appropriate data collection agency on the movement of goods between statistical territories.

Note that EDI or any of its subsets including EDIFACT / CUSDEC INSTAT may be transmitted via network, diskette, tape, or as an e-mail attachment.

IDEP / CN 8

INTRASTAT Data Entry Package / Combined Nomenclature 8 Digits (IDEP / CN8) is a software package used to create and report movement statistics declarations. In Europe, the Statistical Office of the European Communities (Eurostat) has developed this software packaged to reduce the burden and complexity of making movement statistics declarations.

The IDEP / CN 8 software package is usually available, free of charge, from the government agencies responsible for the collection of INTRASTAT data. Please refer to
your local government agency for details about obtaining the software.

With this software you can enter movement statistic data (manually or importing it from external system) and validate the data. IDEP will then configure the data into the correct format as required by the government agency.

The IDEP software package generates an EDIFACT standard CUSDEC/INSTAT file. In addition, movement statistic declarations may be sent via diskette or as an e-mail attachment.

Combined Nomenclature 8 Digits (CN8) is a software package that can be installed either as a stand alone package or as part of IDEP. This software is also available free of charge. Combined Nomenclature codes are used for the identification of goods in movement statistic declarations. This software packages helps create the movement statistic declarations by making the CN8 codes corresponding to the goods imported and / or exported easily available.

Neither IDEP nor CN8 is mandatory. You may submit movement statistics declaration using an ASCII format file based on published standards.

ASCII File

You may submit movement statistics declaration using an ASCII format file based on published standards. The format of the ASCII files differs by country, you need to refer to the specific country requirements if you choose to transmit movement statistics declarations using this format.

e-Commerce Gateway

This section reviews creating Movement Statistics EDI transactions with Oracle's E-Commerce Gateway, including:

• Overview of Movement Statistics and EDI

• Pre-Requisites for Movement Statistics and EDI

• Process Flow

**Note:** To generate and transmit movement statistics via EDI, you must be working from the Oracle e-Commerce Gateway application. This section outlines the steps up to the point where the e-Commerce Gateway extracts movement statistics. For detailed instructions, please refer to the Oracle e-Commerce Gateway User's Guide.
Overview of Movement Statistics and EDI

Oracle e-Commerce Gateway supports Intrastat and Extrastat requirements by providing for the automatic extraction and electronic processing of movement statistics. However, you must first create the movement statistics transactions using the Movement Statistics Processor.

Subsets of the EDIFACT Customs Declaration (CUSDEC) message are used to report material movement statistics. The CUSDEC subset known as INSTAT reports movement statistics within the European Union. The CUSDEC EXSTAT reports movement statistics between countries of the European Union and any country outside of the European Union.

Only movement statistics records with a movement status of 'verified' or 'frozen' are extracted by the Oracle E-Commerce Gateway. Once the movement statistic records are extracted, the movement status is set to EDI.

Pre-Requisites

It is assumed that you will be using Oracle’s e-Commerce Gateway to generate and transmit movement statistic EDI transactions.

The following are required to create movement statistics EDI transactions through Oracle’s e-Commerce Gateway:

• Installation and implementation of Oracle e-Commerce Gateway

Note: Oracle e-Commerce Gateway can transmit your movement statistic records via EDI, however it is up to you to determine if the recipient is able to receive your EDI transmission and to conduct the proper testing with the recipient.
Run e-Commerce Outbound Process

Transmitting Intrastat declaration via Oracle e-Commerce Gateway process:

1. Create and Verify movement statistics records by running the Movement Statistics Processor
   
   **Note:** the status of all records to be transmitted via the e-Commerce Gateway must be either verified or frozen

2. Log onto the Oracle e-Commerce Gateway application

3. Enter all the required parameters to extract movement statistics records

4. Select the Movement Statistics (MVTSO) transaction to transmit movement statistics

5. From the e-Commerce Gateway, run the Movement Statistics Extract Concurrent Program

   Refer to the Oracle e-Commerce Gateway User Guide for detailed instructions
Creating Export Data File

This section reviews creating the data export flat file using the Movement Statistics Date Export concurrent program, including:

- Overview of Oracle's Data Export functionality
- Overview of Oracle's IDEP Support
- Pre-Requisites for Using the Data Export Program and IDEP
- Process Flow

**Note:** it is assumed that you have installed the IDEP software and performed all required setup.

Data Export Overview

Oracle Movement Statistic's solution will create a data export file with all the necessary data for you to make legal declarations via electronic means including EDI and IDEP. You use the Movement Statistics Create Export Data concurrent program to create this data file.

You may create an export data file for the following movement types:

- Arrivals
- Arrival Adjustments
- Dispatch
- Dispatch Adjustments

Only movement statistics records with a status of FROZEN within a given reporting period will be extracted to create the data export file. You should verify that all movement records that you want the Data Export concurrent program to extract have a status of FROZEN.

Once the Movement Statistics Create Data Export concurrent program has run, the status of all movement records that were extracted to create the data export file will be updated to EXPORT. Movement records, once their status is updated to EXPORT, can
not be extracted again by the Data Export concurrent program. This prevents movement transactions from being extracted and reported more than once on legal declarations.

IDEP Support Overview

Using the Movement Statistics Data Export concurrent program, you create a flat file that can be imported into IDEP. IDEP will then generate the appropriate Intrastat arrival or dispatch declaration.

The file generated by the Data Export concurrent program contains all Intrastat mandated data for every European Community country. However, since every country that uses IDEP has different reporting requirements, you should be familiar with your country’s reporting requirements to configure the IDEP Software for your country’s specific regulations.

Prerequisites

Note the following prerequisites to running the Movement Statistics Data Export concurrent program:

1. Verify that you have correctly set up the Intrastat commodity codes in Oracle Inventory.

2. Verify that the VAT numbers of all your suppliers and customers have been entered. For suppliers, the VAT number must be entered in Oracle Purchasing. For customers, the VAT number must be entered in Oracle Order Management.

3. Run the Movement Statistics Official Summary Report for the period when you will be running the Movement Statistics Data Export concurrent program. The Official Summary Report will update the status of all movement records to FROZEN. Note that the status for all records for the period you have chosen must be VERIFIED before running the Official Summary Report. The Official Summary Report will not run if movement records exist with a status of OPEN in the selected period.

4. The Data Export concurrent program will only extract movement records with a status of FROZEN. You should verify that the status of all movement records are FROZEN before running the Data Export concurrent program.

5. To make legal declarations with IDEP, you must have installed and configured the IDEP software on your system. It is assumed that you have completed and tested your IDEP configuration for your specific country before proceeding. Refer to the country specific IDEP user’s guide for complete installation and configuration instructions.

The format of the data export file created by the Data Export concurrent program
may be found in the Appendix of this document. Note that the data export file format cannot be modified. You must modify the IDEP Software import file format to read the data export file created by the Data Export concurrent program. Refer to the IDEP User’s Guide for complete instructions on modifying the IDEP import file format.

Movement Statistics Create Export Data Concurrent Program

1. Run the Movement Statistics Official Summary Report to update the status to FROZEN.

The status of all records for the specified period must be 'frozen' before running the Data Export concurrent program.

2. Run the Movement Statistics Data Export concurrent program.

Enter the following parameters to submit this concurrent program:

- Legal Entity
- Economic Zone
- Usage Type
- Statistical Type
• Movement Type
• Period Name
• Currency
• Exchange Rate

This concurrent program creates the data export file that can be imported into IDEP.

3. Verify that the concurrent program completed successfully.

Once the export flat file has been created, copy it to a local directory (on the PC that you have installed the IDEP software) to have the IDEP software import the data.

4. Copy the data export file to your PC with the following steps:

The process of copying the data export file to your local PC is different in every system. This process generically outlines the steps to copy the data export file to your PC.

You need the request id for the Data Export concurrent program. The request id will be different for every run of the Data Export concurrent program.

Copy the Export file

5. Locate the output file created by the execution of the Data Export concurrent program

You can view all request output by using the View > Requests command from the Toolbar.

6. Open the output file created by the Data Export concurrent program

To view the output for a specific request, click View Output.

7. Copy the file to your PC by using the Tools / Copy command

The Tools drop down menu is located on the Toolbar and the Copy command is a Tools menu option.

8. After issuing the Copy command, a new browser window will open with the contents of the Data Export output file

A new browser window will open.

9. Save the output file to your local PC from the browser window using the Save As command

Use the Save As command, located on the browser's Toolbar under 'File > Save As.
10. On the Save As window, enter the path and file name for your data export file. After entering the filename and location, save your file. You should save your file as a text file.

11. Verify that the file was copied to the location you specified. Navigate to the location of your file to verify that the save was successful on your PC.

12. Log onto IDEP on your local PC. Start and run the import process from the IDEP software.

13. Import the data export file you just copied into IDEP. Specify the path to the data export file in IDEP. Once imported, verify the data and create your legal declaration.

Related Topics

IDEP User’s Guide

Troubleshooting

This section reviews the troubleshooting movement statistics declarations.

Error with Official Summary Report

The Official Summary Report concurrent program ends in error.

Data Export Concurrent Program does not Create a data file.

After you run the Data Export concurrent program, the data file created does not contain any data.

Cause

The most likely cause for this error is that not all the movement statistics records for the period in which the report was run are in status of VERIFIED. All records must be in status of VERIFIED and there must not be any records with the status of OPEN. You have not updated the status of your movement records to FROZEN before running the Data Export concurrent program.

Solution

Review all the records for the period in which the report was run, any records with the status of OPEN must be changed to a status of verified. The Data Export concurrent
program only processes records with a status of FROZEN. Verify that you have run the Movement Statistics Official Summary Report for the specified period. The only way in which you can update the status of movement records is by running this report. All records processed by the Data Export program will have a status of EXPORT and will not be processed again by this concurrent program.
Adjustments to Movement Records

This chapter covers the following topics:

- Making Adjustments
- Manual Record Adjustments
- Making Retroactive Price Adjustments
- Automatic Record Adjustment

Making Adjustments

To make accurate declarations, Oracle’s Movement Statistics solution gives you the ability to make adjustments to movement statistics records. You may make adjustments either:

- before you make your declaration
- after you have made your declaration

In general, changes to declared movement records may be required due to:

- a return of goods
- an adjustment of prices
- a data correction on a movement record

Note that declaring adjusted movement records is governed by rules and regulations of the different EU countries. It is assumed that you are familiar with the specific requirements of your country.

Manual Record Adjustments

This section reviews making manual adjustments to movement records.
Making Adjustments to Records before Declaration

You may modify existing movement records at any time before they are declared. Before making adjustments to records, you must determine their status.

Records with the following status may be adjusted, without modifying their status:
- open
- verified

Records with the following status may be adjusted, you will be required to modify their status to open before making any adjustment:
- frozen
- summarized
- aggregate
- export
- ignore

Once the status has been updated to open, you may make adjustments to the records. After making adjustments, you will be required to reverify the records, either on-line or by running the Movement Statistics Exception Report in preparation for making a declaration.

Making Adjustments to Records after Declaration

It is strongly recommended that you do not modify an existing movement record that has been previously declared. Making modifications to declared records raises the possibility of declaring the same record twice, that would affect the accuracy of your declaration.

If a previously declared movement record requires adjustment, create a separate, manual adjustment record instead. You create a manual adjustment record with the corrected values and declare the manual record as your adjustment. The original record is not modified. The benefits of creating manual adjustment records is two-fold:
- you do not report the same transaction record twice
- an audit trail of the original transaction and the adjustment transaction

To create a manual adjustment record, use the Miscellaneous Transaction Type:
Using the Movement Statistics Detail form, you would create the necessary adjustment record:
Making Retroactive Price Adjustments

Retroactive pricing is generally not used within the countries of the European Union, where movement statistics for INTRASTAT reporting is used. It can be used when a company is given special dispensation from their government to do so.

Users of Oracle Purchasing can update purchase order prices retroactively, regardless of whether the order has been received or invoiced. Consequently, purchase orders that have been processed by the movement statistics processor must be adjusted with the new prices. The movement statistics processor creates an arrival movement record for purchase order receipts. To update the price information on an arrival record, you must:

1. Determine which PO receipts have been affected by retroactive prices adjustments.

2. Identify the arrival movement record corresponding to the price adjusted PO receipt.

3. Determine the movement status of the movement record.

4. Update the arrival movement record or create new arrival movement record (if the movement status indicates update).
5. Create an arrival adjustment record (if the movement status indicates creation).

Step 1: To determine which PO receipts have been affected by retroactive prices adjustments:

You have two ways of determining if a PO has been affected by a price adjustment:

- Review the output after running the concurrent program Retroactive Price Update of Purchasing Documents. This is a concurrent program in Oracle Purchasing.

- When you or an Oracle Purchasing user manually updates the prices of releases or standard purchase orders, note the release numbers or purchase order numbers of the purchasing documents that have been updated.

  Note: You must use Oracle Purchasing for both these functions.

Step 2: To identify the arrival movement record corresponding to the price adjusted PO receipt:

After you have determined the releases and purchase orders that have been price adjusted, you must identify and locate the arrival movement record corresponding to the adjusted PO receipt.

In the Find Movement Statistics window you can locate the arrival movement record by searching for either the purchase order number or the receipt number:

In the Advanced tab, enter the following data:

- Source Type: Purchase Order

- Document Number: Purchase Order Number or

- Document Number: Purchase Order Number

- Transaction: Receipt Number

- Find the record using the Find button. The arrival movement statistics record corresponding to the PO receipt is displayed.

  Note: If the release or purchase order has not been received or if the Movement Statistics Processor has not been run, an arrival movement record will not exist for the release or purchase order.
Step 3: To determine the movement status of movement statistics record:

After you have located the arrival movement record, the status of the movement record is determined.

1. Navigate to the Movement Statistics Details window.

2. Find the Movement Status field.

3. The possible status of a movement record include:
   - Open
   - Verified
   - Frozen
   - Pending
   - Ignore
   - Export
   - EDI

4. If the status of the movement record is Open or Verified, you can either:
   - Update the existing arrival movement record.
   - Create a new arrival movement record.

5. If the status of the movement record is either Frozen, Export, or EDI, you can create a new arrival adjustment movement record.

6. If the status of the movement record is either Pending or Ignore, do not update an existing movement record or create a new movement record.

Step 4: To update movement statistics record:

If the status of the arrival movement record status is either Open or Verified and it has been invoiced, update the existing arrival movement record.

Note: Update a movement record only if it has been invoiced. Never adjust a movement record that has not been invoiced.

To update an arrival movement record, complete the following steps:
1. Navigate to the Movement Statistics Details window, Additional Details tab.

2. Know the amount of the PO was price adjusted (this information is available from the output files of the Retroactive Price Update of Purchasing Documents concurrent program or from the notes taken when a PO was price adjustment).

3. Enter the price adjustment, as either a fixed amount or a percentage. The price adjustment will automatically update the Statistical Value. Also, consider the following points:
   - The Statistical Value is not displayed on the Movement Statistics windows.
   - The Movement Amount is not updated by the price adjustment.
   - The Invoice Amount is not updated by the price adjustment.
   - The Statistical Value is only displayed on the Movement Statistics Reports.

   **Note:** The Movement Amount reflects the most current invoice amount before a price adjustment is applied. When invoiced, the Movement Amount is updated to reflect the current invoice price.

   - The Statistical Value is declared along with the Movement Amount.

4. Save your work.

**Step 5: To create arrival movement statistics record**

Alternatively, instead of updating an existing arrival movement record, you can create a new arrival movement record if the movement record status is either Open or Verified, and if it has been invoiced. Complete the following steps to create an arrival movement:

1. Navigate to the Movement Statistics Summary window.

2. Select File > New to display the Transaction Types window. Enter the Legal Entity, and Transaction Type = Miscellaneous.

3. Click OK.

**Automatic Record Adjustment**

The Movement Statistics Exception Report will automatically create the following movement statistics records:

- Arrival Adjustment Records
• Dispatch Adjustment Records

Arrival or dispatch adjustment records will only be created for movement records that have not been invoiced. If the record has been previously invoiced and declared an adjustment record will not be created. If you must modify an existing record that has been both invoiced and declared, you will need to create a manual adjustment.

Arrival Adjustment Records

The Movement Statistics Exception Report will create an Arrival Adjustment Record under the following conditions only (all the following conditions must be met):

• The arrival record was not invoiced in the reporting period in which it was created.

• The arrival record is invoiced, but in a later reporting period.

• The status of the arrival record is FROZEN.

• The reporting period when the arrival record was created is closed.

If these conditions are met, a new Arrival Adjustment record will be created referring to the original arrival record. The status of the adjustment record will be open and you will be required to verify this record and declare as you would any movement record. The invoice information will be included in the adjustment record. Note that the original record will not be modified and the status will remain frozen. You will declare the arrival adjustment record in the period for which it was created.

Dispatch Adjustment Records

The Movement Statistics Exception Report will create an Dispatch Adjustment Record under the following conditions only (all the following conditions must be met):

• The dispatch record was not invoiced in the reporting period in which it was created.

• The dispatch record is invoiced, but in a later reporting period.

• The status of the dispatch record is FROZEN.

• The reporting period in which the dispatch record was created is closed.

If these conditions are met, a new Dispatch Adjustment record will be created referring to the original dispatch record. The status of the adjustment record will be open and you will be required to verify this record and declare as you would any movement record. The invoice information will be included in the adjustment record. Note that the original record will not be modified and the status will remain frozen. You will declare the dispatch adjustment record in the period in which it was created.
This chapter covers the following topics:

- Movement Statistics Record Purge Utility
- Movement Statistics Reset Status Utility

Movement Statistics Record Purge Utility

This section outlines the Movement Statistics Record Purge Concurrent Program.

The Movement Statistics Transaction Purging Concurrent Program will delete specified Movement Statistics records. Note that once the records are purged, they can not be recreated. Before purging any records, it is strongly recommended that you make a backup of the records, either using paper based reports or electronic media.

Movement Statistics Transaction Purging Process Flow:

1. Enter the parameters to identify the movement statistics records to purge
2. Submit the program for execution

Movement Statistics Reset Status Utility

The Movement Statistics Reset Status concurrent program will reset the status of all movement statistics records for a specified period and transaction type to OPEN. Records with a status of IGNORE may also be reset to OPEN.

The Reset Status concurrent program will, by default, update ALL records for a specified Legal Entity and period to OPEN status. If you only want to update movement records with a status of IGNORE to OPEN, you must specify the correct Reset Option parameter before running this concurrent program.

To update the status of movement records using the Movement Statistics Reset Status concurrent program:
1. Navigate to the Movement Statistics Reset Status concurrent program.

2. Enter the following parameters to execute the Reset Status concurrent program:
   - Legal Entity
   - Economic Zone
   - Usage Type
   - Statistical Type
   - Period Name
   - Document Source
   - Reset Option

3. You may set the Reset Option parameter as follows:
   - Blank – all movement records as specified by the previous parameters will be updated to OPEN
   - All – the same as leaving the parameter blank, all movement records as specified by the previous parameters will be updated to OPEN
   - Exclude Ignore – the status of all movement records specified by the parameters will be updated to OPEN except those records with IGNORE status
   - Ignore Only -- the status of all movement records with status of IGNORE as specified by the parameters will be updated to OPEN. Record with any other status will not be updated to OPEN
This appendix covers the following topics:

- European Union Member Countries
- Movement Statistic Field Definitions
- Movement Statistics Record Status
- User Defined Validation Rules
- Export Data File Format

European Union Member Countries

The countries that make up the European Union are as follows. Note that the European Union Economic Zone is pre-seeded in the system.

<table>
<thead>
<tr>
<th>Code</th>
<th>Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>AT</td>
<td>Austria</td>
</tr>
<tr>
<td>FR</td>
<td>France</td>
</tr>
<tr>
<td>BE</td>
<td>Belgium</td>
</tr>
<tr>
<td>IE</td>
<td>Ireland</td>
</tr>
<tr>
<td>DK</td>
<td>Denmark</td>
</tr>
<tr>
<td>IT</td>
<td>Italy</td>
</tr>
<tr>
<td>Code</td>
<td>Country</td>
</tr>
<tr>
<td>------</td>
<td>---------------</td>
</tr>
<tr>
<td>DE</td>
<td>Germany</td>
</tr>
<tr>
<td>LU</td>
<td>Luxembourg</td>
</tr>
<tr>
<td>FI</td>
<td>Finland</td>
</tr>
<tr>
<td>NL</td>
<td>Netherlands</td>
</tr>
<tr>
<td>GB</td>
<td>United Kingdom</td>
</tr>
<tr>
<td>PT</td>
<td>Portugal</td>
</tr>
<tr>
<td>GR</td>
<td>Greece</td>
</tr>
<tr>
<td>SE</td>
<td>Sweden</td>
</tr>
<tr>
<td>ES</td>
<td>Spain</td>
</tr>
</tbody>
</table>

**Movement Statistic Field Definitions**

The following is an alphabetized listing of the fields, and their definitions, used in the Movement Statistics forms and reports. The following is an alphabetized listing of the fields, and their definitions, used in the Movement Statistics forms and reports.

**Adjustment Percentage**

This field is not populated by the Movement Statistics Processor.

This field will adjust the Statistical Value by the percentage entered. A negative percentage will decrease the Statistical Value, a positive percentage will increase the Statistical Value.

Note that the Statistical Value is not displayed on-line. The adjusted Statistical Value will be displayed on the Movement Statistics Standard Summary or Standard Detail Reports. Also, note that if you enter an adjustment percentage, the Adjustment Amount will automatically be calculated for you.

You may manually enter this value on the Movement Statistics Detail form or use the Call Out Program.
**Adjustment Amount**

This field is not populated by the Movement Statistics Processor.

This field will adjust the Statistical Value by the amount entered. A negative amount will decrease the Statistical Value, a positive amount will increase the Statistical Value.

The Statistical Value is not displayed on-line. The adjusted Statistical Value will be displayed on all the Movement Statistics Standard Summary or Standard Detail Reports. Note that if you enter an adjustment amount, the Adjustment Percentage will automatically be calculated for you.

You may manually enter this value on the Movement Statistics Detail form or use the Call Out Program.

**Adjustment to**

Refers to the Movement Number of original movement record. This field will only be populated on adjustment movement records, otherwise it is blank. For example, if the current record is an adjustment movement record, this field refers to the movement record that is being adjusted.

**Affiliation Reference**

This field is not populated by the Movement Statistics Processor.

You may update this field manually or by using the Call Out Program to insert an affiliation reference code.

**Alternate Quantity**

This field is not populated by the Movement Statistics Processor.

This field is used if a commodity code requires a Supplementary Unit.

In the Commodity Codes nomenclature, the commodity codes for which supplementary units have to be used, such as number of items, pairs, dozens, etc. - are indicated. This is done because, for some products it is necessary to define the quantity or volume of a product. This measurement in terms of the supplementary unit must be entered for the commodity code marked by an asterisk in the nomenclature. You must not enter the unit itself.’ from: Intrastat - Guide 2001

**Alternate UOM**

This field is not populated by the Movement Statistics Processor.

This field is used if a commodity code requires a Supplementary Unit.

'In the Commodity Codes nomenclature, the commodity codes for which supplementary units have to be used, such as number of items, pairs, dozens, etc. - are
indicated. This is done because, for some products it is necessary to define the quantity or volume of a product. This measurement in terms of the supplementary unit must be entered for the commodity code marked by an asterisk in the nomenclature. You must not enter the unit itself. from: Intrastat - Guide 2001

**Area**

This field is not populated by the Movement Statistics Processor.  
This field is used to enter the predefined code which specifies the area the goods arrived or departed from a specific EC member state. The pre-seeded list for Area is too large to display in this document. You may manually enter this value by selecting from the pre-seeded list of values on the Movement Statistics Detail form or use the Call Out Program.

**Batch**

The batch number that processed either the Purchase Order or Sales Order invoice. The batch number is generated by your system when processing invoices.

**Comments**

This field is not populated by the Movement Statistics Processor.  
A free text field. You may manually enter free text comments in this field or use the Call Out Program.

**Commodity**

Goods are classified by means of commodity codes.  
The commodity code for the INTRASTAT transaction -- a predefined character code which uniquely identifies a class of products. The European Community has a set of harmonization codes that are 8 characters with a ninth digit - check digit.  
The Commodity Code is an 8 digit number taken from the Intrastat Classification Nomenclature (ICN) which is common to all EU countries. The coding system distinguishes between the various types of goods (for example, steel, foodstuffs, machinery) and goes into considerable detail. It is often ambiguous - for example, if you are shipping a consignment of screws intended as spare parts for motor vehicles, you have an option to declare them either specifically as 73181569 under a code for 'screws' or else more vaguely under the code 87089910 for 'Vehicle spare parts.' It is quite possible, if the exporter is a manufacturer of screws and the importer is a manufacturer of vehicles, that the seller could use one code for the export declaration, and the buyer a different code for the import declaration.  
In the Movement Statistics module, Commodity Codes and Descriptions are derived from the category set defined at setup time in the Movement Statistics Parameters form: the commodity code for a movement statistics record is the category to which the item
involved in the transaction is assigned within that category set.

In the Movement Statistics module, this is known as the Commodity Code and includes the field Commodity Code Description.

**CSA Code**

This field is not populated by the Movement Statistics Processor.

The Canadian Standard Association (CSA) develops standards that covers the electrical/electronic, communications, quality management systems, environmental, construction, gas, healthcare, and public safety fields. Each standard is coded.

You must enter the CSA Code manually or by using the Call Out program.

**Customer Name**

For sales order transactions, the customer name is displayed.

**Customer Number**

For sales order transactions, the customer number is displayed.

**Customer Site**

For sales order transactions, the customer site is displayed.

**Date (Invoice)**

The date the invoice was created.

**Delivery Terms**

The current list of EU Delivery Codes are sometimes referred to as Incoterms and were established in part by the International Chamber of Commerce (ICC) to determine at which point the transfer of title takes place in a transaction where goods are bought or sold.

Delivery Codes are required to perform Intrastat reporting. The current set of valid EU delivery codes are setup automatically in the Movement Statistics module. Additional Delivery Codes may be added as necessary to the Movement Statistics Module.

The Movement Statistics module uses lookups to select the value for Delivery Code. Following is a list of pre-seeded data provided for this purpose.

In the Movement Statistics module, the Delivery Code for a movement transaction is defaulted from the Freight on Board (FOB) point (of a transaction) and verified against the valid Delivery Codes. Current valid Delivery Codes:
• EXW - ex works
• FVA - Free Carrier
• FAS - Free Alongside Ship
• FOB - Free on Board
• CFR - Cost and Freight (C&F)
• CIF - Cost, Insurance, and Freight
• CPT - Carriage Paid to Agreed Destination
• DAF - Delivered at Frontier
• DES - Delivered ex Ship
• DEQ - Delivered ex Quay
• DDU - Delivered Duty Unpaid
• DDP - Delivered Duty Paid
• XXX - delivery terms other than above

The default Delivery Code for all Source types is CIF - Cost, Insurance, and Freight

Delivery Name
For sales order transactions, the delivery name is displayed.

Destination Country
The country code to which the goods are shipped.

In the Movement Statistics module, Dispatch Country is defined to be the country to which the goods are being shipped. For example, if a PC was shipped from France to a customer in Spain, the Destination Country would be Spain.

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Destination Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>RECV - Purchase Order Receipt</td>
<td>Ship to Location</td>
</tr>
</tbody>
</table>
## Movement Statistics Data

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Destination Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRNI / TRNR - Inventory Move Transactions</td>
<td>To Organization</td>
</tr>
<tr>
<td>RTNR - Return to Vendor</td>
<td>Ship to Location</td>
</tr>
<tr>
<td>ADJI - Customer Return</td>
<td>Ship to Location</td>
</tr>
<tr>
<td>XFER - inventory In-transit Transfer</td>
<td>To Organization</td>
</tr>
<tr>
<td>Sales Order</td>
<td>Ship to Location</td>
</tr>
<tr>
<td>Purchase Order</td>
<td>Ship to Location</td>
</tr>
<tr>
<td>Inventory Move Transactions</td>
<td>To Organization</td>
</tr>
<tr>
<td>Return to Vendor (RTV)</td>
<td>Ship to Location</td>
</tr>
<tr>
<td>RMA</td>
<td>Ship to Location</td>
</tr>
<tr>
<td>Drop Shipments</td>
<td>Triangulation</td>
</tr>
<tr>
<td>Internal Sales Order / Internal Requisitions</td>
<td>To Organization</td>
</tr>
</tbody>
</table>

### Dispatch Country

The Dispatch Country is the country code from which the goods are shipped.

In the Movement Statistics module, Dispatch Country is defined to be the country from where the goods are shipped. For example, if a PC was shipped from France to a customer in Spain, the Dispatch Country would be France.

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Dispatch Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>RECV - Purchase Order Receipt</td>
<td>Vendor Site</td>
</tr>
<tr>
<td>TRNI / TRNR - Inventory move Transactions</td>
<td>From Organization</td>
</tr>
<tr>
<td>RTNR - Return to Vendor</td>
<td>Ship from Location</td>
</tr>
</tbody>
</table>
### Source Type

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Dispatch Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADJI - Customer Return</td>
<td>From Organization</td>
</tr>
<tr>
<td>XFER - inventory in-transit Transfer</td>
<td>From Organization</td>
</tr>
<tr>
<td>Sales Order</td>
<td>Ship from Location</td>
</tr>
<tr>
<td>Purchase Order</td>
<td>Vendor Site</td>
</tr>
<tr>
<td>Inventory Move Transactions</td>
<td>From Organization</td>
</tr>
<tr>
<td>Return to Vendor (RTV)</td>
<td>Ship from Location</td>
</tr>
<tr>
<td>RMA</td>
<td>From Organization</td>
</tr>
<tr>
<td>Drop Shipments</td>
<td>Triangulation</td>
</tr>
<tr>
<td>Internal Sales Order</td>
<td>From Organization</td>
</tr>
</tbody>
</table>

### Document Number

The document number for the INTRASTAT transaction (as defined by the document type). The document number / transaction cross-reference:

Inventory, Purchasing, and Order Management Source Types

### Source Type / Document Number

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Document Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Order</td>
<td>Sales Order Number</td>
</tr>
<tr>
<td>Purchase Order</td>
<td>PO Number</td>
</tr>
<tr>
<td>Inventory Move Transactions</td>
<td>Transaction ID</td>
</tr>
<tr>
<td>Return to Vendor (RTV)</td>
<td>RTV Number</td>
</tr>
<tr>
<td>RMA</td>
<td>RMA Number</td>
</tr>
</tbody>
</table>
### Source Type

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Document Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop Shipments</td>
<td>Order Number</td>
</tr>
<tr>
<td>internal Sales Order / Internal Requisitions</td>
<td>Requisition Number</td>
</tr>
</tbody>
</table>

### Document Reference

This field is not populated by the Movement Statistics Processor.

For Miscellaneous movement records (manually created records) you may enter free text information regarding the document in this field.

### Document Line Reference

This field is not populated by the Movement Statistics Processor.

For Miscellaneous movement records (manually created records) you may enter free text information regarding the document line in this field.

### Economic Zones

In the Movement Statistics module, you define economic zones as an association of countries.

### Exchange Rate

The Exchange Rate is the rate used to convert between the transaction currency to the functional currency.

In the Movement Statistics module, the Exchange Rate is entered by the user. The Exchange Rate is calculated by multiplying the Transaction currency by the Set of Books exchange rate to arrive at the Functional (reporting) currency exchange rate.

### Flow Indicator

This field is not populated by the Movement Statistics Processor. Flow Indicator Code refers to the flow of goods and the pre-seeded values include:

- 0 - Bonded warehouse goods out to home country with an origin of home country
- 1 - Bonded warehouse export of goods
- 2 - Bonded warehouse storage under customs regulation
- 3 - Bonded warehouse goods out to home country
- 4 - Bonded warehouse storage of tax exempt goods
5 - Bonded warehouse movement of tax exempt goods
6 - Import / intra EU arrival
7 - Export / intra EU dispatch

You may manually enter this value by selecting from a pre-seeded list of values on the Movement Statistics Detail form or use the Call Out Program.

**Functional (Reporting) Currency**

In the Movement Statistics module, the Functional Currency is the currency used in reporting movement transactions (either paper based or electronically). All movement transactions transacted in another currency (the Transaction Currency) will require conversion. The Exchange Rate is the rate used to convert between the transaction currency to the functional / reporting currency.

For countries in the EU that have converted to the Euro, all transactions not in the Euro must be converted into the Euro.

**GL Period**

The General Ledger period in which the transaction took place.

**Invoice Line**

The invoice line number.

**Invoice Number**

The invoice number, usually generated by the system that processes invoices. This field is populated only if the transaction has been invoiced.

**Invoice Quantity**

The quantity invoiced as it appears on the invoice. This field is populated only if the transaction has been invoiced.

**Invoice Unit Price**

The invoice unit price as it appears on the invoice. This field is populated only if the transaction has been invoiced.

**Invoice Extended Value**

The invoice extended value calculated by multiplying the invoice unit price by the invoice quantity. This field is populated only if the transaction has been invoiced.
**Inventory Item / Item Description**

The item and item description.

In the Movement Statistics module, the ID of the transacted item as well as the description of the transacted item.

**Inventory Organization**

The inventory organization where the transaction took place is displayed.

**Legal Entity / Economic Zones Associations**

In the Movement Statistics module, users can specify the list of economic zones for which movement statistics need to be generated for a legal entity.

**Mineral Oil Reference**

This field is not populated by the Movement Statistics Processor. This field refers to the type of oil being transacted. The pre-seeded values include:

01 - Boiling Point Benzene, Refinery Resource Gasoline, Motor Fuel, Lub Oil, or Propane
02 - Other special Benzene, Feedstock Gasoline, Fuel Oil, Lub Gel, or Propane / Butane
03 - Waste Oil or Other
04 - Unmarketable Oil Products
05 - Other Heavy Oil Products

You may manually enter this value by selecting from a pre-seeded list of values on the Movement Statistics Detail form or use the Call Out Program.

**Movement Amount**

This field is calculated by the Movement Statistics Processor by multiplying the document unit price by the document quantity.

For example, in the a sales order transaction, the unit price and quantity are obtained from the sales order. In a purchase order transaction, the unit price and quantity are obtained from the purchase order.

**Movement Number**

In the Movement Statistics module, a unique numeric movement ID is assigned to each movement transaction. The Movement Number is generated by the Movement Statistics module automatically.
Movement Type

The Movement Type indicates whether the movement transaction is a: Arrival - report on all arrival movement statistics – receipt of goods transactions into economic zone countries

- Arrival Adjustment - report on all adjustments to prior period arrival movement statistics

- Dispatch - report on all dispatch movement statistics – sales order / movement of goods transactions from economic zone countries

- Dispatch Adjustment - report on all adjustments to prior period dispatch movement statistics

In the Movement Statistics module, the Movement Type is determined and assigned based on the Source Type, as follows:

Source Type / Movement Type

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Movement Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales order</td>
<td>Dispatch</td>
</tr>
<tr>
<td>Purchase Order</td>
<td>Arrival</td>
</tr>
<tr>
<td>Inventory Move Transactions</td>
<td>Arrival / Dispatch (2 movement transactions; from Org - dispatch, to org - arrival)</td>
</tr>
<tr>
<td>Return to Vendor (RTV)</td>
<td>Dispatch</td>
</tr>
<tr>
<td>RMA</td>
<td>Arrival</td>
</tr>
<tr>
<td>Drop Shipments</td>
<td>Both Arrival and Dispatch</td>
</tr>
<tr>
<td>Internal Sales Order / Internal Requisitions</td>
<td>Dispatch</td>
</tr>
<tr>
<td>RECV - Purchase Order</td>
<td>Arrival</td>
</tr>
<tr>
<td>TRNI / TRNR - Inventory Move Transactions</td>
<td>Arrival / Dispatch (2 movement transactions: from Org - dispatch, to Org - arrival)</td>
</tr>
<tr>
<td>RTNR - Return to Vendor</td>
<td>Dispatch</td>
</tr>
</tbody>
</table>
### Movement Status

Each movement statistics record is associated with a status that can assume one of the following values:

- **Verified** - record validated by the exception report
- **Frozen** - record reported to the government through paper based report
- **EDI sent** - record reported to the government through EDI transaction

In the Movement Statistics module, once a movement statistics record has been reported to the government either on paper or using EDI, the record is set in a frozen status to avoid any modification or multiple reporting. Users have the option to reset the status of a reported batch of records in case they are refused by the authorities.

### Origin

The country of origin is defined to be the country where the goods took on their current state. For example, if a PC were assembled in the US and then sold out of a distribution office from France to a customer in Spain, the country of origin would be the US.

In the Movement Statistics module, the purchase order receipt transaction correctly lists the Country of Origin of the item on the PO lines. For all other movement transactions, proper country of origin data is not available and the Country of Origin attribute is defaulted from the Dispatch Country.

Using the example above – if a PC were assembled in the US and then sold out of a distribution office from France to a customer in Spain, the country of origin would be the US – the country of origin would be reported as follows in the Movement Statistics module:
### Country of Origin

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Country of Origin</th>
<th>Dispatch Country</th>
<th>Destination Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>RECV - Purchase Order Receipt</td>
<td>US</td>
<td>France</td>
<td>Spain</td>
</tr>
<tr>
<td>TRNI / TRNR - Inventory Transactions</td>
<td>France*</td>
<td>France</td>
<td>Spain</td>
</tr>
<tr>
<td>RTNR - Return to Vendor</td>
<td>France*</td>
<td>France</td>
<td>Spain</td>
</tr>
<tr>
<td>ADJI - Customer Return</td>
<td>France*</td>
<td>France</td>
<td>Spain</td>
</tr>
<tr>
<td>XFER - Inventory In-transit Transfer</td>
<td>France*</td>
<td>France</td>
<td>Spain</td>
</tr>
</tbody>
</table>

* Dispatch Country is used at the Country of Origin

### Outside Cost Price Code

If the transaction involves outside processing, the price code is displayed.

### Outside Costs Unit Price

If the transaction involves outside processing, the outside processing unit price is displayed.

### Outside Costs Extended Value

If the transaction involves outside processing, the outside processing extended value is calculated by multiplying the outside unit price by the transaction quantity.

### Period Name

The reporting period when the transaction took place.

### PO Number

The purchase order number generated by the system that processed the purchase order.
**PO Line**

The purchase order line number.

**Port**

This field is not populated by the Movement Statistics Processor.

The port is the port or airport of unloading in the case of arrivals and the port or airport of loading in the case of dispatches. The pre-seeded list is too large to display in this document.

You may manually enter this value by selecting from a pre-seeded list of values on the Movement Statistics Detail form or use the Call Out Program.

**Report Reference**

The Movement Statistics Official Summary report assigns a report reference number to all movement records that have been processed by the Official Summary Report. This report also updates the status of movement records to FROZEN.

**Process Organization**

For Oracle Process Manufacturing transactions, the Process Organization is displayed.

**Quantity**

The transaction quantity (in the transaction / source type specified).

In the Movement Statistics module, this field is also known as Quantity and is in the transaction unit of measure.

**Receipt Number**

The purchase order receipt number. The receipt number is generated by the system that processed the receipt.

**Release Number**

The release number of a purchase order release. This field is populated only if the transaction has a release number.

**Reporting Tools**

Movement Statistics reporting requirements includes reporting the total statistical and transaction value, the total weight, and the total number of records per reporting period.
The Movement Statistics module reports the total quantities for the default unit of measure and the sum of the value of the transactions per reporting period:

- Statistical value
- Transaction Value
- Total Weight
- Number of movement transactions

**SO Line**

The sales order line number.

**SO Number**

The sales order number generated by the system that processed the sales order.

**Source Type**

In the Movement Statistics module, movement transactions are known as Source Types. Valid Inventory, Purchasing and Order Management transaction types are as follows:

- purchase order Receipts
- Return to Vendor (RTV)
- Sales Orders
- Return Material Authorization (RMA)
- Supplier Drop Shipments (triangulation)
- Multiorg Intercompany Drop Shipments
- Inventory interorganization Movements
- Internal Requisitions and Internal Sales Orders

**Statistical Procedure**

This field is not populated by the Movement Statistics Processor.

In general, Statistical Procedure refers to the commercial nature of a shipment and to some extent replicates the information in the transaction nature code.

The pre-seeded list of Statistical Procedures is too large to display in this document.
You may manually update this field by selecting from the seeded list of values on the Movement Statistics Detail form or use the Call Out Program to insert your own Statistical Procedure values.

**Transaction Nature Codes**

The transaction nature code – code based on the characteristics of the transaction. A one or two digit code which identifies the class of transaction in which the movement of goods was involved for example sale, loan, and demo.

The Movement Statistics module uses lookups to select the value for Transaction Nature, Following is a list of pre-seeded data provided for this purpose.

In the Movement Statistics module, the Transaction Nature Code for a movement transaction is determined and assigned based on the Source Type and verified against the valid Transaction Codes.

The default Transaction Nature Codes for the specified Source Types (as used by the Movement Statistics module) are as follows:

<table>
<thead>
<tr>
<th>Transaction Nature (default)</th>
<th>Source Type</th>
<th>Transaction Nature Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sales Order</td>
<td>Transaction involving ownership change</td>
</tr>
<tr>
<td>1</td>
<td>Purchase Order</td>
<td>Transaction involving ownership change</td>
</tr>
<tr>
<td>1</td>
<td>RECV - Purchase Order</td>
<td>Transaction involving ownership change</td>
</tr>
<tr>
<td>2</td>
<td>RMA</td>
<td>Returned goods</td>
</tr>
<tr>
<td>2</td>
<td>ADJI - Customer Return</td>
<td>Returned goods</td>
</tr>
<tr>
<td>4</td>
<td>Return to Vendor (RTV)</td>
<td>goods for processing or repair</td>
</tr>
<tr>
<td>4</td>
<td>RTNR</td>
<td>Goods for processing or repair</td>
</tr>
<tr>
<td>6</td>
<td>Inventory Move Transactions</td>
<td>Movement of goods without the transfer of ownership except process or repair</td>
</tr>
</tbody>
</table>

Movement Statistics Data   A-17
<table>
<thead>
<tr>
<th>Transaction Nature (default)</th>
<th>Source Type</th>
<th>Transaction Nature Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>TRNI / TRNR - Inventory Move Transactions</td>
<td>movement of goods without the transfer of ownership except process or repair</td>
</tr>
<tr>
<td>6</td>
<td>XFER - Inventory In-transit Transfer</td>
<td>Movement of goods without the transfer of ownership except process or repair</td>
</tr>
<tr>
<td>9</td>
<td>Drop Shipments</td>
<td>Other</td>
</tr>
<tr>
<td>9</td>
<td>Internal Sales Order / Internal Requisitions</td>
<td>Other</td>
</tr>
<tr>
<td>12</td>
<td>Consignment transaction</td>
<td>An arrival record with Transaction code = 12 is created for consigned receipts</td>
</tr>
<tr>
<td>21</td>
<td>Returned goods</td>
<td>A dispatch record with Transaction code = 21 is created for consigned returns</td>
</tr>
</tbody>
</table>

**Movement Statistics Record Status**

A movement statistics record can have one of the following values:

1. OPEN: This is the initial status of all movement statistics records. At the time the Movement Statistics Processor creates a record, the record status is OPEN. You can modify a record in this status.

2. VERIFIED: A record’s status is updated from OPEN to VERIFIED after the Movement Statistics Exception Report is then run. The Exception Report validates all records with a status of OPEN and all records that pass validation (that is, the record is error-free according to validation rules) will have a status of VERIFIED. Only movement records that pass validation will have a status of VERIFIED. All movement records with errors will remain in status OPEN. You can modify a record in this status but the record status will revert to OPEN.

3. EDI: If a record is transmitted via EDI, the statuses of those records are updated to EDI. Only records with the status of VERIFIED may be updated to EDI. You can not modify a record in this status.
4. FROZEN: The Movement Statistics Official Summary Report will update all VERIFIED movement records to FROZEN. Once a movement record’s status has been updated to FROZEN, it may not be modified. You can not modify a record in this status.

5. EXPORT: If a record is extracted by the Data Export File concurrent program, the record status is updated to EXPORT (from FROZEN). You can not modify a record in this status.

6. PENDING: If a movement record has not been invoiced and the Reference Period Rule is Invoiced Based the record will have a status of PENDING. The Reference Period Rule must be set to Invoiced Based for a movement record to have a status of PENDING. If the Reference Period Rule is Shipment Based, movement records will not have a status of PENDING. You can modify a record in this status.

7. IGNORE: Only a movement record with a status of OPEN or VERIFIED may be updated to IGNORE. Once a record status of a record has been updated to IGNORE, the Movement Statistics Processor will no longer process the record, nor will this record be reported on any Movement Statistics Report. The Data Export concurrent program will not process records with a status of IGNORE. Movement records will remain in status of IGNORE unless manually updated on-line or by the running the Movement Statistics Reset Status concurrent program. You can modify a record in this status.

Modification Methods

You can use one of the following methods to modify a record status:

- Movement Statistics Reset Status Concurrent Program: This concurrent program will update all records, except those with a status of IGNORE, within a specified legal entity and period to OPEN. You may update movement records with a status of IGNORE to OPEN with this concurrent program.

- Movement Statistics Exception Report: This report will update a record’s status from OPEN to VERIFIED after being validated (only records that are successfully validated will have their status updated to VERIFIED, record that fail validation will remain with a status of OPEN.

- Movement Statistics Processor: The processor creates movement statistics records with a status of OPEN or PENDING.

- Movement Statistics Data Export File: The status of all movement statistics records processed by this concurrent program are updated to EXPORT.

- EDI: Any record transmitted via Oracle's e-Commerce Gateway will have their status updated to EDI.
• Movement Statistics Official Summary: This concurrent program will update the status of all VERIFIED records to FROZEN.

• Online: Individual movement records may be updated on-line using the Movement Statistics Detail form. Movement records may be updated in the following manner:
  1. from IGNORE to OPEN
  2. from VERIFIED to IGNORE
  3. from OPEN to VERIFIED
  4. from OPEN to IGNORE

Supplementary Units

The requirement for Supplementary Units is part of the Intrastat Classification Nomenclature (ICN), and only applies to certain classes of products. The nature of the Supplementary Unit depends on the product; commonly, it may be the number of units, or the volume in liters, or the area in square meters, for example:

• Live animals: the number of animals shipped
• Skis: the number of pairs
• Diamonds: carats

Supply Name

For purchase orders, the supplier number.

Supply Site

For purchase orders, the supplier site (address).

Supply Reference

This field is not populated by the Movement Statistics Processor.

Currently you may manually update the fields with the following values: '0' for transactions based on CSA Codes or '1' for transactions not based on CSA Codes. You may insert your own codes using the Call Out Program

TARIC Code

This field is not populated by the Movement Statistics Processor.

The TARIC (Integrated Tariff of the European Communities) code is designed to show
the various rules applying to specific products when imported into the EU. This includes the provisions of the harmonized system and the combined nomenclature but also additional provisions specified in Community legislation such as tariff suspensions, tariff quotas, and tariff preferences, that exist for the majority of the Community’s trading partners. In trade with third countries, the 10-digit Taric code must be used in customs and statistical declarations. (From: Office of Agricultural Affairs, US Mission to the European Union.)

You must enter the TARIC Code manually or by using the Call Out program.

**Total Weight**

The total weight is calculated by multiplying unit weight by quantity.

**Transaction Date**

The date of the movement statistics transaction. In the Movement Statistics module, this is known as the Transaction Date. The date is derived from each valid Source Type:

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Transaction Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Order</td>
<td>Sales Order Date</td>
</tr>
<tr>
<td>Purchase Order</td>
<td>PO Date</td>
</tr>
<tr>
<td>Inventory Move Transactions</td>
<td>Transaction Date</td>
</tr>
<tr>
<td>Return to Vendor</td>
<td>RTV Date</td>
</tr>
<tr>
<td>RMA</td>
<td>RMA Date</td>
</tr>
<tr>
<td>Drop Shipments</td>
<td>Order Date</td>
</tr>
<tr>
<td>Internal Sales Order / Internal Requisitions</td>
<td>Requisition Date</td>
</tr>
</tbody>
</table>

**Transaction Reference**

This field is not populated by the Movement Statistics Processor.

For Miscellaneous movement records (manually created records) you may enter free text information regarding the transaction in this field.
Transport Code

The Mode of Transportation code. A one-digit code indicating how the goods are transported.

The Movement Statistics module uses lookups to select the value for Transport Mode Code. The following is a list of pre-seeded data for this purpose.

In the Movement Statistics module, the Transportation Mode Code is defaulted from the freight carrier of the movement transactions and verified against the valid EU Transportation Mode Codes.

The valid EU Transportation Mode Codes are as follows:

1. Transport by sea
2. Transport by rail
3. Transport by road
4. Transport by air
5. Consignments by post
6. Fixed transport installations
7. Transport by inland waterways
8. Own propulsion

The default Transportation Code for all source types is 3- Transport by road

Example
In the UK, upon creating a movement transactions, you must show the active mode of transport at the international border, as known to the trader.

Transport Container

This field is not populated by the Movement Statistics Processor.

This field is not populated by the Movement Statistics Processor. You may update this field manually with a value of '0' indicating that a transport container was not used, or '1' indicating that a transport container was used.

You may also use the Call Out Program to insert a transport container code.

Transaction Currency

In the Movement Statistics module, the Transaction Currency is the currency used in the transaction. The currency on the Source Type is the Transaction Currency. The
Exchange Rate is the rate used to convert between the transaction currency to the functional or reporting currency.

For example, suppose that the Source Type is Sales Order with a currency of US Dollars, but the reporting currency is the Euro. The Movement Statistics module will use the exchange rate (as defined by the user) to convert between USD and Euro.

**Transaction Nature Codes Used by Movement Statistics**

<table>
<thead>
<tr>
<th>Code</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Transaction involving the change of ownership</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>Transaction involving the change of ownership</td>
</tr>
<tr>
<td>11</td>
<td>11</td>
<td>Transaction involving the change of ownership</td>
</tr>
<tr>
<td>12</td>
<td>12</td>
<td>consignment transaction involving the change of ownership</td>
</tr>
<tr>
<td>13</td>
<td>13</td>
<td>Barter transaction involving change of ownership</td>
</tr>
<tr>
<td>14</td>
<td>14</td>
<td>Traveler personal expenses</td>
</tr>
<tr>
<td>15</td>
<td>15</td>
<td>Lease transaction involving change of ownership</td>
</tr>
<tr>
<td>16</td>
<td>16</td>
<td>Credit note for 10 transaction</td>
</tr>
<tr>
<td>17</td>
<td>17</td>
<td>Type 10 shown on supplementary, not VAT return</td>
</tr>
<tr>
<td>18</td>
<td>18</td>
<td>Type 10 shown on VAT not supplementary return</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>Returned goods</td>
</tr>
<tr>
<td>20</td>
<td>20</td>
<td>Returned goods and replacement goods</td>
</tr>
<tr>
<td>Code</td>
<td>Meaning</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>21</td>
<td>21</td>
<td>Returned goods</td>
</tr>
<tr>
<td>22</td>
<td>22</td>
<td>replacement of returned goods</td>
</tr>
<tr>
<td>23</td>
<td>23</td>
<td>replacement of unreturned goods</td>
</tr>
<tr>
<td>26</td>
<td>26</td>
<td>Credit note for type 20 transaction</td>
</tr>
<tr>
<td>28</td>
<td>28</td>
<td>type 20 shown on Vat return not supplementary return</td>
</tr>
<tr>
<td>30</td>
<td>30</td>
<td>Free of charge transactions involving change of ownership</td>
</tr>
<tr>
<td>31</td>
<td>31</td>
<td>EU program free of charge transaction</td>
</tr>
<tr>
<td>32</td>
<td>32</td>
<td>Other government free of charge transaction</td>
</tr>
<tr>
<td>33</td>
<td>33</td>
<td>Other free of charge transaction</td>
</tr>
<tr>
<td>36</td>
<td>36</td>
<td>Credit note for type 30 transaction</td>
</tr>
<tr>
<td>37</td>
<td>37</td>
<td>Type 30 shown on supplementary, not VAT return</td>
</tr>
<tr>
<td>38</td>
<td>38</td>
<td>Type 30 shown on VAT, not supplementary return</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>Goods for processing or repair</td>
</tr>
<tr>
<td>40</td>
<td>40</td>
<td>Goods for processing or repair</td>
</tr>
<tr>
<td>Code</td>
<td>Meaning</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>41</td>
<td>41</td>
<td>Goods for processing</td>
</tr>
<tr>
<td>42</td>
<td>42</td>
<td>Goods for repair or maintenance</td>
</tr>
<tr>
<td>43</td>
<td>43</td>
<td>Goods for free of charge repair or maintenance</td>
</tr>
<tr>
<td>46</td>
<td>46</td>
<td>Credit note for type 40 transaction</td>
</tr>
<tr>
<td>47</td>
<td>47</td>
<td>Type 40 shown on supplementary, not VAT return</td>
</tr>
<tr>
<td>48</td>
<td>48</td>
<td>Type 40 shown on VAT, not supplementary return</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>Goods returned following process or repair</td>
</tr>
<tr>
<td>51</td>
<td>51</td>
<td>Goods returned following processing</td>
</tr>
<tr>
<td>52</td>
<td>52</td>
<td>Goods returned following repair or maintenance</td>
</tr>
<tr>
<td>53</td>
<td>53</td>
<td>Goods returned following free of charge repair or maintenance</td>
</tr>
<tr>
<td>56</td>
<td>56</td>
<td>Credit note for type 50 transaction</td>
</tr>
<tr>
<td>57</td>
<td>57</td>
<td>Type 50 shown on supplementary, not VAT return</td>
</tr>
<tr>
<td>58</td>
<td>58</td>
<td>Type 50 shown on VAT, not supplementary return</td>
</tr>
<tr>
<td>Code</td>
<td>Meaning</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>Movement of goods without the transfer of ownership except process or repair</td>
</tr>
<tr>
<td>60</td>
<td>60</td>
<td>Movement of goods without transfer of ownership</td>
</tr>
<tr>
<td>61</td>
<td>61</td>
<td>Movement of goods involving lease or rental</td>
</tr>
<tr>
<td>62</td>
<td>62</td>
<td>Other movement of goods not involving ownership change</td>
</tr>
<tr>
<td>66</td>
<td>66</td>
<td>Credit note for type 60 transaction</td>
</tr>
<tr>
<td>67</td>
<td>67</td>
<td>Type 60 shown on supplementary, not VAT return</td>
</tr>
<tr>
<td>68</td>
<td>68</td>
<td>Type 60 shown on VAT, not supplementary return</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>Joint defense or intergovernmental programs</td>
</tr>
<tr>
<td>70</td>
<td>70</td>
<td>Joint defense or intergovernmental programs</td>
</tr>
<tr>
<td>71</td>
<td>71</td>
<td>Joint defense or intergovernmental programs</td>
</tr>
<tr>
<td>72</td>
<td>72</td>
<td>Airbus program</td>
</tr>
<tr>
<td>76</td>
<td>76</td>
<td>Credit note for type 70 transaction</td>
</tr>
<tr>
<td>77</td>
<td>77</td>
<td>Type 70 shown on supplementary, not VAT return</td>
</tr>
<tr>
<td>Code</td>
<td>Meaning</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>78</td>
<td>78</td>
<td>Type 70 shown on VAT, not supplementary return</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>Supply of building materials and equipment</td>
</tr>
<tr>
<td>80</td>
<td>81</td>
<td>Supply of building materials and equipment</td>
</tr>
<tr>
<td>81</td>
<td>81</td>
<td>Supply of building materials and equipment</td>
</tr>
<tr>
<td>86</td>
<td>86</td>
<td>Credit note for type 80 transactions</td>
</tr>
<tr>
<td>87</td>
<td>87</td>
<td>Type 80 shown on supplementary, not VAT return</td>
</tr>
<tr>
<td>88</td>
<td>88</td>
<td>Type 80 shown on VAT, not supplementary return</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>Other transactions</td>
</tr>
<tr>
<td>90</td>
<td>90</td>
<td>Other transactions</td>
</tr>
<tr>
<td>91</td>
<td>91</td>
<td>Other transactions</td>
</tr>
<tr>
<td>92</td>
<td>92</td>
<td>Receiving of goods, put in inventory for distribution to customers afterward</td>
</tr>
<tr>
<td>96</td>
<td>96</td>
<td>Credit note for type 90 transaction</td>
</tr>
<tr>
<td>97</td>
<td>97</td>
<td>Type 90 shown on supplementary, not VAT return</td>
</tr>
<tr>
<td>98</td>
<td>98</td>
<td>Type 90 shown on VAT not supplementary return</td>
</tr>
</tbody>
</table>
### Triangulation

The country involved in a triangular trade transaction. This field is populated only for triangulation transactions.

**Example**

Your customer is located in Germany and places a sales order with you in France and you source the order from the Netherlands. In this case, the triangulation country would be the Netherlands.

### Unit Price

The price of a single unit of the item transacted in the movement record.

### Unit Weight

The weight of a single unit of the item transacted in the movement record.

### Usage Type / Statistical Type

Movement transactions are divided into two groups, as follows: For each legal entity / economic zones users define which statistical types, such as INTRASTAT or EXTRASTAT, need to be recorded for each type of movement (Internal - movement of goods within countries of the economic zone - or External movement of goods from a country of the economic zone to a country outside the zone).

**Usage Type, Statistical Type, and Description**

<table>
<thead>
<tr>
<th>Usage Type</th>
<th>Statistical Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal</td>
<td>Intrastat</td>
<td>Movement transactions within the economic zone, for example the EU.</td>
</tr>
<tr>
<td>External</td>
<td>Extrastat</td>
<td>Movement transactions outside of the economic zone, for example, between France and the US.</td>
</tr>
</tbody>
</table>
The Movement Statistics module determines Usage Type and Statistical Type based on the Dispatch and Destination Country codes.

**Unit of Measure (UOM)**

The unit of measure for the transaction quantity. In Movement Statistics this is known as the UOM.

**Value**

Value is defined as the monetary value of the movement in the default currency for the legal entity.

Oracle’s movement statistics solution calculates value as follows:

\[
\text{Value} = \text{unit price} \times \text{transaction quantity}
\]

**Outside Value**

The Outside Value is calculated by multiplying the outside unit price by the transaction quantity. Outside value includes the price of services.

**Invoice Value**

The Invoice Value is calculated by multiplying the invoice price (as recorded on the Invoice) by the invoice quantity. The Invoice Value is displayed in the Transaction Currency.

**Transaction Value**

The Transaction Value is calculated by multiplying the Invoice amount by the Exchange Rate (the parameter value you enter when running the Movement Statistics report). The Transaction Value is displayed in Functional Currency.

**Statistical Value**

The value of the movement or transaction of goods exclusive of VAT but inclusive of transport costs within the border of own EC member state multiplied by the exchange rate (the parameter value you enter when running the Movement Statistics report). The Transaction Value is displayed in Functional Currency. This value is the delta between the Transaction Value and the Statistical Value. This is a manual modification.

**User Defined Validation Rules**

The following Source Types (transaction types) may be modified in a user defined Validation Rule Set:

1. Customer Return
2. Inventory
3. Internal Order
4. Miscellaneous
5. Purchase Order
6. Sales Order

The source types above use the following Attribute Names (fields)
1. Transaction Code
2. Transportation Mode
3. Port Deliver Terms
4. Statistical Procedure Code
5. Area
6. Outside Code
7. Outside Cot Unit Price
8. Outside Cost Extended Value
9. Supply Reference
10. Oil Reference Code
11. Container Type Code
12. Flow Indicator Code
13. Affiliation Reference Code

**Note:** Each Source Type uses all 13 of the Attribute Names (fields) listed. You must define a property for each Attribute Name.

When defining your Attribute Rule Set, you must defined one of the following Attribute Rule Set Property combinations:
- required / not updateable
- not required / updateable
- required / updateable
- not required / not updateable
Export Data File Format

The following is the format of the data export file created by the Movement Statistics Data Export concurrent program.

Arrival Record Format

1. The Country of Consignment is the dispatch country

2. Invoice Value, Invoice Number, and Invoice Currency: if an invoice exists, these fields are populated. If no invoice exists, the Invoice Value is populated with the Movement Amount, Invoice Number, and Invoice Currency are not populated

3. Province / Department / German State Code: all refer to the Area.

Arrival Data Export File

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Position</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commodity Code</td>
<td>The Intrastat Nomenclature commodity code</td>
<td>1</td>
<td>8</td>
</tr>
<tr>
<td>Consignment Country (2 digit)</td>
<td>The trading partner country, for arrivals, the country of dispatch, for dispatches, and the destination country.</td>
<td>9</td>
<td>2</td>
</tr>
<tr>
<td>Consignment Country (3 digit)</td>
<td>The trading partner country, for arrivals, the country of dispatch, for dispatches, and the destination country.</td>
<td>11</td>
<td>3</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
<td>Position</td>
<td>Length</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
<td>--------</td>
</tr>
<tr>
<td>Transaction Nature</td>
<td>A one or two digit code based on the characteristics of the transaction. It identifies the class of transaction in which the movement of goods was involved, for example sale, loan, or demo</td>
<td>14</td>
<td>2</td>
</tr>
<tr>
<td>Transport Mode</td>
<td>A one-digit code indicating how the goods are transported.</td>
<td>16</td>
<td>1</td>
</tr>
<tr>
<td>Statistical procedure / Regim</td>
<td>This code denotes the commercial nature of the shipment (similar to the transaction nature).</td>
<td>17</td>
<td>5</td>
</tr>
<tr>
<td>Port</td>
<td>The Port is the location of transshipment associated with the movement transaction.</td>
<td>22</td>
<td>5</td>
</tr>
</tbody>
</table>
| Area / Province / Department / German State Code | Area / Province / Department / German State Code  
Predefined code which specifies the area the goods arrived or departed from a specific EC member state.                                                                                              | 27       | 10     |
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Position</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incoterms / Delivery Terms</td>
<td>The current list of EU Delivery Codes are sometimes referred to as Incoterms and were established in part by the International Chamber of Commerce (ICC) to determine at which point the transfer of title takes place in a transaction where goods are bought or sold.</td>
<td>37</td>
<td>3</td>
</tr>
<tr>
<td>Incoterm Supplement</td>
<td>For France (only), the standard delivery terms / incoterms must be declared together with an extra character (a 1 or 2) which indicates whether transportation costs are paid in France or elsewhere.</td>
<td>40</td>
<td>1</td>
</tr>
<tr>
<td>Weight (Net Mass)</td>
<td>The weight (mass) of the transaction in Kilograms.</td>
<td>41</td>
<td>15*</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
<td>Position</td>
<td>Length</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
<td>--------</td>
</tr>
<tr>
<td>Supplementary Units</td>
<td>The Supplementary Units is part of the Intrastat Classification Nomenclature (ICN), and only applies to certain classes of products. The nature of the Supplementary Unit depends on the product; commonly, it may be the number of units, or the volume in liters, or the area in square meters.</td>
<td>56</td>
<td>15*</td>
</tr>
<tr>
<td>Origin Country (3 digits)</td>
<td>The country from which the goods originated.</td>
<td>71</td>
<td>2</td>
</tr>
<tr>
<td>Statistical Value</td>
<td>The value of the movement or transaction of goods exclusive of VAT but inclusive of transport costs within the border of own EC member state multiplied by the exchange rate.</td>
<td>73</td>
<td>15*</td>
</tr>
<tr>
<td>Invoice Value Local Currency</td>
<td>The value to the invoice in the local currency specified.</td>
<td>88</td>
<td>15*</td>
</tr>
<tr>
<td>Invoice Value Foreign Currency</td>
<td>The value to the invoice in the foreign currency specified.</td>
<td>103</td>
<td>15*</td>
</tr>
<tr>
<td>Invoice Number</td>
<td>The invoice number of the transactions if there is one available.</td>
<td>118</td>
<td>25</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
<td>Position</td>
<td>Length</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------</td>
<td>--------</td>
</tr>
<tr>
<td>Invoice Foreign Currency (Currency Code)</td>
<td>The invoice reporting currency.</td>
<td>143</td>
<td>3</td>
</tr>
<tr>
<td>Trading Partner VAT Number</td>
<td>The VAT number of the trading partner.</td>
<td>146</td>
<td>20</td>
</tr>
<tr>
<td>Free Text</td>
<td>Free text area</td>
<td>166</td>
<td>200</td>
</tr>
</tbody>
</table>

*The maximum length is 15 digits or 12 digits + 2 decimals (a total of maximum 15 characters long).

**Dispatch Record Format**

Note the following for the Dispatch data export file:

1. The Country of Consignment is the destination country

2. Invoice Value, Invoice Number, and Invoice Currency: if an invoice exists, these fields are populated. If no invoice exists, the Invoice Value is populated with the Movement Amount, Invoice Number, and Invoice Currency are not populated

3. Province / Department / German State Code: all refer to the Area

**Dispatch Record Format**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Position</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commodity Code</td>
<td>The Intrastat Nomenclature commodity code.</td>
<td>1</td>
<td>8</td>
</tr>
<tr>
<td>Consignment Country (2 digit)</td>
<td>The trading partner country, for arrivals, the country of dispatch, for dispatches, and the destination country.</td>
<td>9</td>
<td>2</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
<td>Position</td>
<td>Length</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>----------</td>
<td>--------</td>
</tr>
<tr>
<td>Consignment Country (3 digit)</td>
<td>The trading partner country, for arrivals, the country of dispatch, for dispatches, and the destination country.</td>
<td>11</td>
<td>3</td>
</tr>
<tr>
<td>Transaction Nature</td>
<td>A one or two digit code based on the characteristics of the transaction. It identifies the class of transaction in which the movement of goods was involved for example sale, loan, or demo.</td>
<td>14</td>
<td>2</td>
</tr>
<tr>
<td>Transport Mode</td>
<td>A one-digit code indicating how the goods are transported.</td>
<td>16</td>
<td>1</td>
</tr>
<tr>
<td>Statistical Procedure / Regim</td>
<td>This code denotes the commercial nature of the shipment (similar to the transaction nature).</td>
<td>17</td>
<td>5</td>
</tr>
<tr>
<td>Port</td>
<td>The Port is the location of transshipment associated with the movement transaction.</td>
<td>22</td>
<td>5</td>
</tr>
<tr>
<td>Area / Province / Department / German State Code</td>
<td>Predefined code which specifies the area the goods arrived or departed from a specific EC member state.</td>
<td>27</td>
<td>10</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
<td>Position</td>
<td>Length</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
<td>--------</td>
</tr>
<tr>
<td>Incoterms/Delivery Terms</td>
<td>The current list of EU Delivery Codes are sometimes referred to as Incoterms and were established in part by the International Chamber of Commerce (ICC) to determine at which point the transfer of title takes place in a transaction where goods are bought or sold.</td>
<td>37</td>
<td>3</td>
</tr>
<tr>
<td>Incoterm Supplement</td>
<td>For France (only), the standard delivery terms / incoterms must be declared together with an extra character (a 1 or 2) which indicates whether transportation costs are paid in France or elsewhere.</td>
<td>40</td>
<td>1</td>
</tr>
<tr>
<td>Weight (Net Mass)</td>
<td>The weight (mass) of the transaction in Kilograms.</td>
<td>41</td>
<td>15*</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
<td>Position</td>
<td>Length</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
<td>--------</td>
</tr>
<tr>
<td>Supplementary Units</td>
<td>The Supplementary Units is part of the Intrastat Classification Nomenclature (ICN), and only applies to certain classes of products. The nature of the Supplementary Unit depends on the product; commonly, it may be the number of units, or the volume in liters, or the area in square meters.</td>
<td>56</td>
<td>15*</td>
</tr>
<tr>
<td>Origin Country (3 digit)</td>
<td>The country from which the goods originated.</td>
<td>71</td>
<td>2</td>
</tr>
<tr>
<td>Statistical Value</td>
<td>The value of the movement or transaction of goods exclusive of VAT but inclusive of transport costs within the border of own EC member state multiplied by the exchange rate.</td>
<td>73</td>
<td>15*</td>
</tr>
<tr>
<td>Invoice Value Local Currency</td>
<td>The value to the invoice in the local currency specified.</td>
<td>88</td>
<td>15*</td>
</tr>
<tr>
<td>Invoice Value Foreign Currency</td>
<td>The value to the invoice in the foreign currency specified.</td>
<td>103</td>
<td>15*</td>
</tr>
<tr>
<td>Invoice Number</td>
<td>The invoice number of the transactions if there is one available.</td>
<td>118</td>
<td>25</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
<td>Position</td>
<td>Length</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>--------------------------------------------------</td>
<td>----------</td>
<td>--------</td>
</tr>
<tr>
<td>Invoice Foreign Currency (Currency Code)</td>
<td>The invoice reporting currency.</td>
<td>143</td>
<td>3</td>
</tr>
<tr>
<td>Trading Partner VAT Number</td>
<td>The VAT number of the trading partner.</td>
<td>146</td>
<td>20</td>
</tr>
<tr>
<td>Free Text</td>
<td>Free text area.</td>
<td>166</td>
<td>200</td>
</tr>
</tbody>
</table>

*The maximum length is 15 digits or 12 digits + 2 decimals (a total of maximum 15 characters long).
Index

A

Additional Details Tab, 3-14
Alternate Unit of Measure (UOM) Rules, 2-4
Alternate UOM Rule, 2-5
Alternate UOM rules, 2-34
Arrival, 5-3, 6-4
Arrival Adjustment, 5-3, 6-4
ASCII, 1-11
ASCII File, 6-8
Attribute Property, 4-8
Attribute Property Rule Set, 2-32
Attribute Property Validation Rules, 2-4
Attribute Rule Set Code, 4-8

C

Call Out Program, 1-5, 2-35
Combined Nomenclature 8 Digits, 6-8
Commodity Code, 3-5, 4-7
consigned receipts, 3-18
consigned returns, 3-18
Country Details Tab, 3-11
Creating Export Data File, 6-11
Credit/Debit Memos, 3-1
CUSDEC, 6-9
CUSDEC / INSTAT, 6-7
Customs Declaration Message, 6-7

data declarations, movement statistics, 6-x
default Triangulation Mode, 2-19
Define Economic Zones, 2-3
Define Movement Statistics Parameters, 2-6
Delivery Terms, 3-6
design and Create Report, 6-6
destination Country, 3-5
detail Report, 5-2
determine a Reporting Tool, 6-5
determine reporting Requirements, 6-5
dispatch, 5-3, 6-4
dispatch Adjustment, 5-3, 6-4
dispatch Adjustment Records, 4-3
dispatch Country, 3-6
document Number, 3-5

E

economic zone, 1-2
Economic Zone, 3-4
European Union, 2-3
Economic Zone Parameters, 2-10
Economic Zones, 1-3
EDI, 1-4, 1-11, 6-11
EDIFACT, 1-5, 6-9
EDI FACT, 6-7
EDI support, 1-4
Electronic Transmission, 1-10
European Commission, 1-1
European Community, 1-1
European Community Requirements, 1-1
European Union, 1-1, A-1
Exception Report and the System Default
Validations, 4-3
Exception Report and User Defined Validation Rules, 4-4
Exception Report and Warning Messages, 4-4
Exceptions Not Listed on Exception Report, 4-8
Exchange Rate, 4-7
Execute a Saved Query, 3-8
EXSTAT, 1-5
EXTRASTAT, 1-1, 1-5

Find Movement Statistics, 3-4
flexfield structures, 2-2
form
   Additional Details, 3-14
   Country Details, 3-11
   Customer, 2-31
   Detail, 3-10
   Economic Zone, 2-37
   Find Movement Statistics, 3-4, 3-5, 3-6, 4-9
   Invoice Details, 3-13
   Movement Country Details, 3-11
   Movement Details, 3-11
   Movement Statistics, 1-4
   Movement Statistics Detail, 7-3
   Movement Statistics Details, 3-7, 3-10, 4-9
   Movement Statistics Parameter, 2-34
   Movement Statistics Parameters, 2-2, 2-6
   Movement Statistics Summary, 3-6, 3-7, 3-8
   Movement Statistics Validation Rules, 2-4, 2-33
   Statistics Type Usages, 2-6
   Supplier, 2-31
   Validations Rule, 2-32, 2-34
Freight on Board, 2-31
FROZEN, 1-10

ICN, 2-2
IDEP, 6-11
IDEP / CN8, 1-11
IDEP / CN 8, 6-7
IDEP software, 6-8
IGNORE, 4-8
INSTAT, 1-5
Internal Requisitions and Internal Sales Orders,

INSTAT, 6-12
INTRASTAT, 1-1, 1-5
Intrastat Classification Nomenclature, 2-2
Intrastat commodity codes, 2-2
Inventory inter-organization movements, 3-1
Inventory Organization, 3-4
Invoice, 4-7
Invoiced Based, 2-15
Invoice Details Tab, 3-13
Invoice Number, 3-5
Invoices, 3-1

Legal Entity, 3-4
Legal Entity Level Reporting, 1-3
logical classification, 2-2

Making Adjustments to Records after Declaration, 7-2
Manual Record Creation, 1-9
mass update the status, 4-11
Miscellaneous Tab, 3-15
Missing Invoice, 4-4
Missing Invoice exception, 4-8
Missing Value
   Transaction Code, 4-6
modify existing movement records, 7-2
Modifying Triangulation Mode, 2-19
Movement Details, 3-10
Movement Details Tab, 3-11
Movement Id, 4-6
Movement Number, 3-4
Movement Statistics Create Export Data, 6-11
movement statistics declarations, 6-x
Movement Statistics Exception Report, 4-2
Movement Statistics Ignore Record Status, 4-8
Movement Statistics Model, 1-7
Movement Statistics Official Report, 6-2
Movement Statistics Process Flow
   Legal Declarations, 1-7
   Record Creation, 1-7
   Record Reporting, 1-7
   Record Verification, 1-7
Movement Statistics Processor, 1-3, 1-8, 2-18, 3-1
<table>
<thead>
<tr>
<th>Index-3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Movement Statistics Processor Concurrent Program</strong>, 3-1</td>
</tr>
<tr>
<td><strong>Movement Statistics Reports</strong>, 5-1</td>
</tr>
<tr>
<td><strong>Movement Statistics Reset Status</strong>, 4-11</td>
</tr>
<tr>
<td><strong>Movement Statistics Re-Set Status</strong>, 4-10</td>
</tr>
<tr>
<td><strong>Movement Status</strong>, 3-4</td>
</tr>
<tr>
<td><strong>Movement Type</strong>, 3-4</td>
</tr>
<tr>
<td>multiple currency, 1-4</td>
</tr>
<tr>
<td>Multiple-organization drop shipments, 3-1</td>
</tr>
<tr>
<td><strong>NAFTA</strong>, 2-3</td>
</tr>
<tr>
<td><strong>North American Free Trade Association</strong>, 1-1, 2-3</td>
</tr>
<tr>
<td><strong>Official Summary Report</strong>, 1-10</td>
</tr>
<tr>
<td><strong>Oracle e-Commerce Gateway</strong>, 6-2</td>
</tr>
<tr>
<td><strong>Oracle E-Commerce Gateway</strong>, 6-9</td>
</tr>
<tr>
<td><strong>Oracle Inventory</strong>, 2-1</td>
</tr>
<tr>
<td><strong>Oracle Purchasing</strong>, 2-1</td>
</tr>
<tr>
<td><strong>Period Name</strong>, 3-5</td>
</tr>
<tr>
<td><strong>Personal Shortcuts</strong>, 3-8</td>
</tr>
<tr>
<td><strong>Prepayment Invoices</strong>, 3-1</td>
</tr>
<tr>
<td>pre-seeded, 1-2, 2-4</td>
</tr>
<tr>
<td><strong>program</strong></td>
</tr>
<tr>
<td>Movement Statistics Reset Status, 1-11</td>
</tr>
<tr>
<td>Purchase Receipts, 3-1</td>
</tr>
<tr>
<td>Purging Movement Statistics Transactions, 1-4</td>
</tr>
<tr>
<td><strong>Query Tree Structure</strong>, 3-9</td>
</tr>
<tr>
<td><strong>Record Status</strong>, 1-9</td>
</tr>
<tr>
<td><strong>Reference Period</strong>, 2-19</td>
</tr>
<tr>
<td>report</td>
</tr>
<tr>
<td>Detail, 1-10</td>
</tr>
<tr>
<td>Exception, 2-31</td>
</tr>
<tr>
<td>Movement Statistics Exception, 1-4, 2-4, 2-31, 4-1</td>
</tr>
<tr>
<td>Movement Statistics Official Summary, 4-2, 6-12</td>
</tr>
<tr>
<td>Movement Statistics Standard Detail, 3-11</td>
</tr>
<tr>
<td><strong>Summary</strong>, 1-10</td>
</tr>
<tr>
<td><strong>Reporting Requirements</strong>, 1-10</td>
</tr>
<tr>
<td><strong>Report Parameters</strong>, 5-2</td>
</tr>
<tr>
<td><strong>Report Reference</strong>, 3-6</td>
</tr>
<tr>
<td><strong>Required Setup</strong>, 2-1</td>
</tr>
<tr>
<td><strong>Return Material Authorization</strong>, 3-1</td>
</tr>
<tr>
<td><strong>Return to Vendor</strong>, 3-1</td>
</tr>
<tr>
<td><strong>RMA</strong>, 1-3</td>
</tr>
<tr>
<td><strong>RTV</strong>, 1-3</td>
</tr>
<tr>
<td><strong>saving a query for future use</strong>, 3-7</td>
</tr>
<tr>
<td><strong>Setting Triangulation Mode</strong>, 2-19</td>
</tr>
<tr>
<td><strong>Setup and implementation</strong>, 2-1</td>
</tr>
<tr>
<td><strong>Setup Process Flow</strong>, 2-2</td>
</tr>
<tr>
<td><strong>Shipment Based</strong>, 2-15</td>
</tr>
<tr>
<td><strong>Source Details</strong>, 3-12</td>
</tr>
<tr>
<td><strong>Source Type</strong>, 3-5</td>
</tr>
<tr>
<td><strong>Standard_Validation Rule Set</strong>, 4-3</td>
</tr>
<tr>
<td><strong>Standard Sales Orders</strong>, 3-1</td>
</tr>
<tr>
<td><strong>Standard Validation Rule Set</strong>, 4-3</td>
</tr>
<tr>
<td><strong>Statistical Office of the European Communities</strong>, 6-7</td>
</tr>
<tr>
<td>statistical type, 1-2</td>
</tr>
<tr>
<td><strong>Statistical Type</strong>, 1-3, 3-4</td>
</tr>
<tr>
<td>submission parameters</td>
</tr>
<tr>
<td>Dates From, 3-3</td>
</tr>
<tr>
<td>Dates To, 3-3</td>
</tr>
<tr>
<td>Document Source, 3-3</td>
</tr>
<tr>
<td>Legal Entity, 3-3</td>
</tr>
<tr>
<td><strong>Summary Report</strong>, 5-2</td>
</tr>
<tr>
<td>summary reports, 5-2</td>
</tr>
<tr>
<td><strong>Trade statistics</strong>, 1-1</td>
</tr>
<tr>
<td><strong>Transaction Code</strong>, 2-32, 3-6, 4-6</td>
</tr>
<tr>
<td><strong>Transaction Nature</strong>, 2-36</td>
</tr>
<tr>
<td><strong>Transaction Number</strong>, 3-5</td>
</tr>
<tr>
<td><strong>Transaction Purging</strong>, 8-1</td>
</tr>
<tr>
<td>transaction type</td>
</tr>
<tr>
<td>Receive, 2-36</td>
</tr>
<tr>
<td>Return to Vendor, 2-36</td>
</tr>
<tr>
<td><strong>Transmission Methods</strong>, 6-5</td>
</tr>
<tr>
<td>transmission of the declaration, 6-2</td>
</tr>
<tr>
<td><strong>Transportation Mode</strong>, 4-6</td>
</tr>
<tr>
<td><strong>Transport Mode</strong>, 2-32, 3-6</td>
</tr>
</tbody>
</table>
Triangular Trade, 2-17
Triangulation, 3-1
  Invoiced Based, 1-6
  Shipment Based, 1-6
triangulation mode, 1-6
Triangulation Mode parameters, 2-15
Triangulation Support, 1-6

U
Unit Weight, 4-7
usage type, 1-2
Usage Type, 3-4
Usage Types, 1-3
Using the Call Out, 2-36

V
Validate Movement Statistics Records, 1-4
Validation Rule, 1-3
VAT, 6-12
VERIFIED, 1-9

W
What is Oracle Movement Statistics?, 1-1